AWG5000 £ & TF AWG7000 1)—X
FEEEERL—4F

DAY RB—k2—H-7=aF)L

0 A A Tektronix
071-2482-03 /s






AWG5000 LT AWG7000 1)—X
FEREZERL—4

DAY RE3—p-2—H-7=aF7I)

www.tektronix.com Tektronix
071-2482-03 4



Copyright © Tektronix. All rights reserved. {# a5 7 hy =7 8513, Tektronix F7213F O F =P ka & 0
A T5L0OT, REFEEHEEBIOCEBESNOREICEI>THRES N TWVET,

Tektronix #4543, B ERF B I OHFAF OKEZOMOE O FFEICIVRES N TOET, KREONRIX, BEIC
BTSN TWBMOERORNEIZRDEZLOTT, Fio, ARG OB I OMIKIT, TERKERIE W
SHANRTZNWETOT, TOHITEIZZN,

TEKTRONIX 3 X TEK 1% Tektronix, Inc. OB §kpEAE T4,

Tektronix E#& 5t

Tektronix, Inc.

14150 SW Karl Braun Drive
P.O. Box 500

Beaverton, OR 97077

USA

IMEHRARE)E, —E X, BT 7=h/ KR —}:
= JbkPN:1-800-833-9200 £ TR EFHELIIZE W,
= JR oMo Tl www.tektronix.com (27 7B AL | BIELDOMRHEZ BIELLIIZE N,



YT, ALY iou\f HFD B35 1 AR BB L OZFDH ERDIZ oW TRIBS WS e RIFLE T,

_UDT%HE%ﬁﬁfﬁqj R SDZ DL G STl YoEEICE S MBI CEEDE
MzERkETIz ﬁ(ﬁ’é@u”u%fﬂkfiﬁ‘éﬁ VAL T Kﬁfé%%u”uODﬁc?ﬁ&nu%ﬁﬁfﬁLi@‘ PRAEIFIZ Y R 23
ERALITEN {—/:-—/I/ BIORZEHET R EIE, HTLWV T 4 —< U R ZHIS T 572012, #imoGa . Fl23/m4E

mOHBELHVET, Q?ﬁbf\_ﬂ—’\f@*ﬁuu EVa—/b, BLOHELE iéﬁ:fﬁéﬁéﬂiﬁ—

ALRFEIZE D ET —ERAE BT W) | BERRITIE, N%nﬁﬂ;ﬁﬁa‘ﬁ@ﬁﬁmu MR A Gl LT
W& —ERXEO-DDE Y EEZ B W eEEE T, BEIC KB@%%M@@LTu\f:f:“
X aéﬂﬁu%b\ féﬁj EDY—E R H—ZEM L TN EET, zl@éu”m%ma% WCIRESND Y
BT RSN Y 47L B A szé? o> HEIILTWAENOGIT ChoeEE, Yhix, @%%ﬁﬁ%ﬁ#ﬂb
7, ub L. ﬁﬁ@i}%)ﬂﬁ WREINDHIIZOWTIE, TXTOSEE, BRL, fleZz oo e B EHKICEEL
TWTEEET,

ARPRFEIT, AT BN 2268 ] 72T O LI+ 072 k5T BE ORIV AT T2 0D 72 % K e SRR 7213
BEICHEHSNEE o YT, LT OFHICOW T, AMRFEICESE T —E2ERIET LR BEZANVET A,
a) Y S F DS OFIZ LR G DA A — /b AEFLFIT Y —E ADORITHBAECTHBEITH T HEH, b) R
SiRIEANT S R L L @focl/‘&l% RO DAE LT ARG T HER, o) HHERT iiﬁb‘*ﬁ‘774’ﬁﬁuu®ﬁﬂﬂ
(CRV AU FITHERE AR 2T 2B, d) AR P UOE £ IO R LA SNLBEITRB VT, Bud
FITHE ORI L5 Zliiéuﬁ'u@*f th)ﬁF’ﬁiti%’éf”int%ﬂﬂbtk%@é VN X]L?“é*f B,

ZOMFEE . FHRBOE T EORAIR MO H B D DIRFED VI WCBAL TH N BRI L TR 2D
DTT, YHEBIORUZ T, Pt £ 13485 € B AL xﬁ“Zm_ r& ZONTO—HDOBRREIEE HRLET,
R B AE L E TR D S O B ATIE . AMEFEDO R BITICOW TRBEREICIRILS N A ME — DY A 72275
BIRE L0 E3, RIEER S BRI E M EMIREEZITIREBREICOWVW T, YHEBIORZFoR_U 2T, BE
DOEHFMEZFIIBANEIN TW L HICHDLT, — o ELZAVEE A,

[W2 - 15AUG04]






H R

B A T U T T I iii
AT T B D . o v
M C BB B . e v
7 = 1< A vi
BB I R D B T T o vii
[ D5 viii
R B viii
T T L T i e e e X
AR T I D B T I ] o X
B DDA L R N T e 1
b N e N e ) 1
B D B 2
B B D BB R g D e 3
B e D BB A 7 g D e 4
WINAOWS A U/ HF 7 R s T A R T A e e e e e 4
B S AN R N A -3 A 5
GPIB/LAN D B T e ettt et e et e e e et e e e e e e e 5
U —h PC 2R Lo e D N — b 6
D (0 el 6
B R D R A o 7
B R I 8
B DR B Lh 9
T A DA AR b 10
F R =T AT VAT BADYVART T A AT DOVERL oo 11
URART « T 4RI DOVERR .« o e e e 11
TR T T e AT I AR T g D 12
T 2 14
DT e 230 (AWGTO00C S/ U R e ettt e 15
BAF I T eV T oA e ax 7 (AWGTO00C T U)ot 17
DT 230 (AWGSH000C S/ U R) e et e e e 18
B R B 20
D N s R A 20
I 2SR e O " — LDy O I 21
BT e AR o A U B T o R e 22
Elo ToUCKhSCIEEN T T U T S g e e e e e e e e e e e e e e 22
AT e A B T = R 23
B TE T R — D e R AT 0 T 24
RUN T R o 25
A=t SR Qo= Ne Ly VR y OV Ny RN Sl & o~ S 26
= N = R S e A U B W 28
T N T R D R R I 29
AT o B R e N o 30

AWG5000 & AWGT7000 1) —X DAy RA—hk 2 —H 3 =27/l i



B R

A B TR DD o B T 31
D R D R TR AT A I g D 32
Run State I M — Lt T/ T 34
VAL R & =i B D 35
A T 39
T T (T as 03 ) 42
R DT I o 44
Bl A i e 44
R e o € A B S 45
S e 2O = w e 46
T T N R T oot e 47
Eo R PN T et A e B N 48
8 A B e Nl N 49
BT T = D AT N 54
BT D TR R B 56
W aVE O T R T e e 56
R N T 0 D 57
T T D R B o e 58
R Y (=Y 59
B T T 61
R T A I DB T B BT D e 62
L I DA e 2 T D e 63
BT 0D 7 T /R T B e R D e 63
BT D e 64
T R T 67
it O S = 68
DM DB AR A= = 0 D 68
S R e 74
S QUENCE T L R T et 74
U T AR R D 76
YT U T ADVERR e 78
U T R R D 80
L DAVZ<Y oL 04 J S AN 82
FOrCe JUIMD T 0. ettt e e e e e et et e e e e 83
TR TIHD Y — 7 A T A N T T R D e 84
X T 85
BT D R A B o e 85
A A DR R 87
o]

AWG5000 $ & AWGT7000 1) —X DAy RB—hkA—H 7 =a7I)L



REICTHERAWN DI

= _— s —
FICTTHEAVEELSESDIC
NE~OEE AT | AR ORE LIS T A ~DBEZES 13572012, RO
B9 21 ELEZ LKBHALTIZE N,
BERICTHERH W01, KL ORRICHES TTEEN,
B OHDY—E A Y F LSMT, RSF R FIEEZ FEIT LRV TIEEND,

REPAE~NDBRGERTEHICIE
BYLERI—FEERAL TSN, ABEMICEESH, #EAShE CRESN B~ 0

DEFERAL TSN,
AE SEERLTESND, A8 ﬂfﬁz—b@77/1%%1%}%%1&11@@% @ﬂ%& F A7
D TTURRET — | %%n‘éﬁ%ﬁ%@i# AL O N H SR DRI, BN IE L HE

HENTWDLZEZfERL TTEEW,

FTRTDIHFEFDEICH SO TLESU, KR BEOEIRE BT H72010, ARLTOFT R TOEKE
V=X TN TS, KB ERZ R 32802, EROFFEMICHOVWT, i~=o2T7 V%S
BLTLEEN,

b 72 G L&D 112 £ DT O RIEMKZE A DB 20T RN TZE N,

BREVBL TSN, BRI —FOBRVALICE > TEBREDSOVBES N ET, B2 —FE2&XED
RNTLES D, ZOa—REHICT /7 ERAARETHLIEBNLETT,

AN—ZHLEREBTEESE RN TSN I =03 LIORE CAR G B (ESE 72
WTLTEEN,

BEOFENAHAHEZIIEBMESELRNTL S, ARBITHEEDRVAHLBE . B OHLY —
AL EFICHBREL THHoTLEENY,

SHL-RIBRADEMIEE (T TEEN, BEXSA L OLXIC, BHUFEREI S o R — R MM
filt 2T E N,

EBRDZVNECHTIEBESERNTIESLY,
BREDHIA AN HAHHEFITIIHEALELTESLY,
HADREERRATERLULRBICHR TR,

:E’GJJ( BERELTLEEL, WURBERIAEONDLIIR S OHRE T IEOFEMIHOVWTIE, ~=27 /L
REFEEZSRLTEEN,

AWG5000 $ & AWGT7000 1) —X DAy RA—hk2—H 3 =aF7JL iii



REICTHEANELHIC

RKIZa7ILADREE
RKe=aT7 VI RORHGEEFEHRALET,

Q B AERLEMAEELBIIETBENLOHLRERLITHEZ RLET,

c EE: ARGLZOM ORGSR IR E L5 A 0REBLIT /2R LET,

ABGICEHTHETLEAHE

ARG CIE, O HFEE A LET,

® DANGER: 7272 B AMER A MICfER A B KX ATt o 22 RLE T,
B WARNING: AMERAMICARA BRI T AN S LI EEZRLET,

® CAUTION: A& T 02 I B G2 B A D RN H L2 RLET,
ARBELCIE, RO EEHBEHLET,

AA@L/%(I)

Ve i (R o .
~=a7  HEE (%) 7eawy  vy—y OO
VB e DY TR

AWG5000 $ & AWGT7000 1) —X DAy RB—kA—H -7 =a7)L



BEMEICET HHER

@S EICET IR

ORI TR ARG N HE#LT S EMC (electromagnetic compliance), 2244, 3BL OB EE LU 2>
WL ET,

EMC H& 1
EC & EE (EMC)
FE4 2004/108/EC EREERBE M NI & Lk 9, [Official Journal of the European Communities | {2V AR
SN TVDRDOARRICHER L FT,
EN 61326-1 2006: /&, i, IS LOFEBRH RO E 7 I3EE (CxH§ 5 EMC S 2 3
B CISPR 11:2003. S MBI Mg ETIviay Z—7 1, 792 A
® [EC 61000-4-2:2001. #EXMEBEAI2=T 4
= [EC 61000-4-3:2002. BRERAI2=TF
B [EC 61000-4-4:2004. 77 AR hFo Pz b/ N—RARfI0=F 4
B [EC 61000-4-5:2001. BV —¥ - AI2=T+
® [EC 61000-4-6:2003. {5 RF AI=2=7 1
B [EC 61000-4-11:2004. &EEK T MR AI2=T ¢

EN 61000-3-2:2006: AC & & =3Iy ar
EN 61000-3-3:1995: EEDZEAL, &), BLOTU A

R 9 358 PR 4% 5 :

Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom

1 Zo8&E, AEREUNATOERAZERLTWET, FERBCHER AL, BETHBORRNLRAZERHIET,
2 ZO¥BETAMIRICERLZREB T, ZORBRERTILVANVEBZITIvTar BRAETARREMERHIET,
3 ZZIREIT-&TE EMC B ~DOBE A X R THICIE, BRERY —NVREROAN U EF Tz —R - —T VHBRBETT,

AWG5000 $ & AWGT7000 1) —X DAy RA—hk2—H 3 =27/l v



BEMEICET HER

A—R SYT7/ Za2a—P—5VFEEEE (EMC)
ACMA 1296V, IR DO FIF& IZ HEHL -5 Z LT Radiocommunications Act @ EMC $&IEIZE S L CTWET,
B CISPR 11:2003: B I OMeE oIy g FL—7 1, 77 A A, EN 61326-1:2006 |Z #E#L

T

vi

ECEEES(EEBERS

Official Journal of the European Communities (ZFE#iEI TWHIR O FLAEICHERLL £,
R EF5 5 2006/95/EC

® EN 61010-1:2001: &, il F L OVFHR & O 8 1 2L 8 (26 97522 A e v

XEOERZBERRBED) XK
B UL 61010-1:2004, 2nd Edition: & F 215 D H %

2l ks &
m CAN/CSA C22.2 No.61010-1:2004: HIE ., #l4, L OMIEHEBOE FEBICHT TR E2HAE, F 1

il

Z D0 S
B IEC 61010-1:2001: JIE. #HIfH ., BLOEBRHRBROE B IR T2 AL YE

HEBDEE

0 7E % A

TB2EISR
Class 1: 7 — Aff &l 5,

FEEEDERRA

HENBLOZEDENTRAETDHRREENSHDIGE YO RETY, @H ., B ORI/ ERBE L [H

CeipaZngd, it ZoRGIEEIN TWARE TOLE AL TZEN,

B OJHYLE 1 JBYARL ., FIIIR R L IR E OB O AN AL E T, 2o T IVORE X, .
otk BEMEOHLZLON, )= b —AIZHDHHEDTT,

B OJBYLE 2 WE . BRI EMEOBE RO LN AELET, 2L, FRISHBIC Lo TR
BHENEAETH LTI ONEE A, T, EENRF T ARCF R CRAELET, —RF2R
T, R IEENMERE ISR AELET,

AWG5000 $ & AWGT7000 1) —X DAy RB—hkA—H -7 =a7I)L



BEMEICET HHER

B JBYLRE 3 WEMNOHAIEY., FRIIEBE O DICEEMNDOHBIBEYL L7 AR LT IEEEIE DI Y,
BE BEOWTNHEHIN TV RWERNTREALET, HYX., M. JBUIK THEEZOBRENS TR
FEEINTWHHEEL T,

B OGR4 HEMRODHDHE, W, FXFICLVRRANISEEBIES AEC TODIER, —iRIICEI T,

ERE
VBEYLE 2 (IEC 61010-1 DEFEICLD), E: BREH ORI OWTOFA T,

BRICEHTAEEER

ZOk7varTiE, WEORREIZH T B OWTIILET,

HNODEELE
B E- 3oL B— R MRV A VLT BB IROHT AR TG AL % F LTI &,
BEROUTAHIL: ﬂi%%%%%%i%@“éﬁ%‘émi\ FAREIR D @ﬂ%éﬂﬂwﬁ“ AR g T, UL EEET S

PR U AL B X 72 o T2 A BRI ETII A BICHE EL R DM E ﬁnz.izh“(b\iﬁ“ ﬁi% A D H
P fﬁié/ﬁ‘@ﬁﬂ%%‘:ﬁ%#t&) KRS D FEB 5 % BRI A F72 ZHF AT XHINCARB AR IELLLY
YA 7N L TLIEEN,

2002/96/EC (FEHEER -E 1 HEICB T 2H4) . BLU2006/66/EC (FrEmIES) |
-3< BU @%%%{ﬁka:ﬁ?&uﬂ%:&%%bﬂ\i@“ V% A7V FIEITDOWTIE, Tektromx

E IR T v oRuE, 2ol 28 WEEE (Waste Electrical and Electronic Equipment) Dlrectlve
D=7 « YAk (www.tektronix.com) DR —hF / $—EZADIHBEEZSEL TITZE0Y,

KERIZEE T ZEH: — oIS TVLS LCD N4k T2 FIcid. KRB EENTOET,
BEIE T o Tl B~ OEENRLETT, BEIEB LU A2l T, BE VO Hillk o B
BITHIZBF:RITZEN,

1 AWG5000C E7-ix AWGT000C 'V — X D#EICIX, ASICHT2BMTEAINETA,

BIERERIEOIWYKL: LI CRUF T L eafy Ry T UaE A TOET, BT 5L =T IO
Wiz ksE, CRUF T L :'4’/ iL HRZME SN, BRI OB N ERIET, FEMIT
www.dtsc.ca.gov/hazardouswaste/perchlorate Z#Z& ML TL7ZE WY,

ﬁ%%ﬁ(:ﬁﬁﬂ'éiﬁﬂ%ﬂ

- 0) #hZ Monitoring and Control (B4R L OVHIMH) & I243FES I, 2002/95/EC RoHS Directive (&
%%””@ﬁ%mﬁﬁﬁ%gﬁ)ﬂﬁiwﬁ?ﬁ ) @ﬁﬁﬁ .571“6“?‘0

AWG5000 & AWGT7000 1) —X DAy RA—hk 2 —H =27/l vii


http://www.dtsc.ca.gov/hazardouswaste/perchlorate

[FL®HIc

[FLHIC

AR===T7 /LTI, AWG5000 3L TN AWGT7000 2V — (LB B ERL — X DR ELEE T IEIZDOWT
FEALE T, EARNRBIEFIESCH IO W TERIZEHBREINET, MO Wi, i 4 T 1 -
~NVTESBRBLUTEESN, Kv=a 7 i, IROEBRESTRELTOET,

EXAY; 31
AWG5000 3L AWGT000 v U—RD EREEEIZR DO LBV TT,
B Microsoft Windows 7 Professional AL —7 ¢/ 7 « 2 27 5 (AWG5000C LY AWGT7000C 21 —X)

viii

AWGT000C >V —X: AWGT122C & AWGT7082C %l

AWG5000C U —X: AWG5002C 1 AWG5012C 1 AWG5014C !

AWGT000B > U—X: AWGT7121B 4 AWGT122B ! AWGT7061B %, AWG7062B /!
AWG5000B > U—X: AWG5012B 4 AWG5014B i AWG5002B | AWG5004B 7Y

B Microsoft Windows XP Professional A4 XL —7 (7"« 27 A (AWG5000B 8LV AWG7000B 2 U —X)
BT e ) (AT var 025 AT v ar 06 )

B 28wk TFIOHL T —ZH T (AWG5002B B . AWG5012B %Y. AWG5002C 7 | 38 LY AWG5012C 74
DI FFar 03 )
B (A=) —TRBIONEFHET el (AWGT122B B AWGT122C B 38 LT AWGT7082C FL o»
Ir . F T 06 )

B OEE S — A 2T (AWGH000B U — R AWGT000B U —X . BN AWGT000C U —ZAD I F
i 08 Al

B ORM10.4 A2 F (264.2 mm) &3 ERE XGA T — T A AT LA

B T e VT BN LT ERAIIR S T T 4T e = e Z T 2 — R
B UA—NRT )L n—RF AT RFA4T (FF a2 05 )

B USB 2.0 A2 ¥V x—A%&HKR—h
® AN (1000/100/10 Base-T)

B F e A= e f BT 2— A

= it AWG5000CE & U8 AWG7000C 1) — X ) #8E

AWGT122C AWGT082C AWG5014C AWG5002C
il il i} il AWG5012C H il
BRH7FY 12 GS/s(Av 8 GS/s (A4 1.2 GS/s 1.2 GS/s 600 MS/s
NV N =) —FT HZ—J—T7T

1% 24 GS/s) 1% 16 GS/s)
D/A 4y f#He SEwMERIT 10 B (818 A 14 vk

P
AE

32M E£F-IT 64 M (AT =0 01
iny)

16 M E£721E 32 M (A7 var 01 )

AWG5000 $ KT AWGT7000 1) —X DAy RB—hk2—H 7 =a7I)L



FL®HIc

% i- AWG5000C# LT AWG7000C S —X D#tEE (=)

AWGT122C AWGT082C AWG5014C AWG5002C
P A i} i} AWG5012C Al i)
Tz Hh 2 2 4 2

~—hHhH 4 4 8 4 4
BRT7Iws 2V, EHEET ) 4.5 Vpp

IRIE 1V, (73 06 )

BRIEER XL 2 Vpp. 750 MHz GE & E—NR) 2 Vp—p. 250 MHz (i E—NR)
X7 FuarsH# 1 Vpop.3.5GHz(FALZFD/A 0.6 Vp—p. 370 MHz (X AL 27k D/A &—K)

g )

1V, 7.5 GHz (A7 v 2 06

1 CH &—F)
FUBL T — KA e e B EYhAT  2BEYRAET
27 ar 03 ) ar 03 )

5 i AWG5000B & & U AWG7000B ') —X D #EE

AWGT121B/ AWGT061B/ AWG5012B/ AWG5002B/
ipa AWGT7122B AWGT062B AWG5014B AWG5004B
BT 12 GS/s(A>%— 6 GS/s 1.2 GS/s 600 MS/s
Lr—Fkr V) — 7 TIix 24

GS/s)

D/A 5 fifhe 8 B hEIE 10 Bk ()8 T RE 14 vk
B E 32M E£-I1L 64 M(FHTF g 01 ) 16 M £721Z 32 M(F 7= 01 )
TFuals 1 F720% 2 2 £771% 4
RRT7FIalRE 2V, (EEET L) 4.5 Vpp
1V, (7= 06 1)
MARIRIERBEIOT 2 Vpp, 750 MHz Gl E—F) 2 Vp—p. 250 MHz GGl fi7 & —F)
RV i3 1 Vp—p. 3.5 GHz (X AL 27~ D/A E—F) 0.6 Vp—p. 370 MHz (¥ AL 27k D/A £—

1 Vp-p, 7.5 GHz (7> 3> 02 £/-1%  F)

F 7 ar 06)
~—hHiH! 2 F7-1% 4 4 F7-1% 8
FOENeF—E  RA] 28 B R (A T ar 03 Al
H 7

1T AWGT7000 > V—XC 10 & by fiREERINERZIL, ~— W H DI C&EEHA

AWG5000 $ & AWGT7000 1) —X DAy RA—hk2—H 3 =27/l ix



[FL®HIc

N=—a7IJlL

ARELEICB T AR FEEROBRBILIIL FTOLBYTT,

SR+ HHEHE ER$TARF2AB

AV AR —ay, BREREE MBSO EEL L — e (L X T o — Ry ba— VI T 5%
BN EIZOWTE, [ Ay 7 AP —he— P evw=a T )1
BTSN,

BIETFEOFME 2 — A X T 2— HHEH /AR TR L RRT Y= e A H T 2= AT 5

AT B~ FELWIH L, Help Ao —0ba—H F oI/~ L7
TIRALET, L TA0 -~ TN, K Ba D FEHERE O T
FERTEHshTWET,

Tag g e~ Help A= a—MH7 0l I< 4 I -~ LT EBRINLET,
Tl e~ VT TIE—havw U RO Ay I AL fHHEICS
BTEEd,

PERE D e RR &A1 A% HEREBLOMERER A FIEICOWTIX, T7=h1 U7 7L A
v =aT VEBRLKEEN, 26D~ =a2 T VIERF a2 A
k CD (2R TUVET,

P —v 2 FE FEV a2 LoV DOEER D SRRIZ DWW TIE, Yk Web T Ah
(www.tektronix.com/manuals) DY —t A ~<w=a2 T )L EZHHRL T
<TEEW,

AY=-a7IDOREHL

IO =aT IV TIEROT A3 AL TWET,

FIIE AT SR EROSERE fyhU—2 PS2 SVGA USB

oA
° L OOO OO

x AWG5000 & AWGT7000 1) —X DAy RB—kA—H -7 =a7)L



BBDARN—IL

DA A —L

MEERABAAL AZ L H —R 77V EL THRHEN T DT R TOMN BN EENTWDHI LA MR LE

T FDOEFHRIZOWTIE, Y4 Web 1k (www.tektronix.com) ZZ L T2 30,

Er SIS Y727 O CD RSN TWET A, BV 7 272 F AL AN— LT 555
13, Yt Web A MBSO B EHRKDO Y 7 =7 2 F 7 a—RLTLEEN,

REVF—R-T7OtYH)

779 Tektronix I 5% =
AWG5000B 35 L TN AWGT7000B 2V —R 7 Ay« AF —h+a—H <
=%
PFE(A T ar LO) 071-2481-xx
HAGE(CE 7 vav L5) 071-2482-xx
R ERE( AT > ar L) 071-2483-xx
BRPEFE( AT T L8) 071-2484-xx
ay T EE( A7 T ar L10) 020-2971-xx
F¥ =242 CD 063-4134-xx
2= F T e VT (TR IR TR 2T D) -
TaT G A TGA e~V (TaF I T 2T D) T
&% —7AR—F (Windows H.#4) 119-7083-xx
~ 7 A (Windows H.#t) 119-7054-xx
DC H/THY—FE>h 012-1697-xx
Al 2SR L s T 2R — 200-4963-xx
TV R—F 016-1441-xx
50 Q SMA #—3x—ar A A, DC ~ 18 GHz (% 3 f#) 015-1022-xx

(AWGT000 U —R D )

IS — RO F OV Fhp i+ )

bk (A7 ar A0)

BN (A7 a2 Al)

HE (A Far A2)

F—=ARZVT (F7ar A3)

AA A (F T a2 AB)

AA (A 7ar Ab)

HFE (A7 ar AL0)

AR (AT ar All)

BRa—RNFEITZAC TH S
HZIpL (A7 3 A99)

AWG5000 $ & AWGT7000 1) —X DAy RA—hk2—H 3 =27/l



HMBEODAAM—IL

BEDEH

c EE: FRPHEEIATOND LI, RO MM E Y & B 72 TSN,

W DOFRE LM 2=+ 222 MR LT, D —hEIIE_ U FICHELET,
= E#6:20 mm (0.8 A F)

B B IO M 150 mm (5.9 A2 F)

= 20 mm (0.8 A F)

B Y75 mm (3 A2 F)

REH

AR DRNS, RSS20 DDA — LTy TENTNDHIEL LT ORDBEEEEMF AL TWDHZ
&% il S L“C<7Zéb\

2 B
1R (BhERE) 10 °C ~ 40 °C (+50 °F ~ +104 °F)
o V8 FEE (a8 1 B ) 30 C (86 °F) LL T CTHEXHTEE 5% ~ 95%

30 °C (86 °F) #& 40 C(104 °F) LA FClX 5% ~ 45%
DOFRHEE ., fi#7e L, fe i ERIE B 29 °C (84.2
°F)

e B (B VERE) 3,000 m (9 10,000 7 4—hK) £ T

BEROEH

BE HABIOEKEDOIAIZZEGT -0, TEIROEBELEBNEFEBLEL PO 10% 2B 2 T
WIZEEFERL TLIZE W,

BRELELEE HEESN
100 VAC ~ 240 VAC. 47 Hz ~ 63 Hz 450 W i (AWGT7000 U —X)
560 W Riifi (AWG5000 U —X)

HYy—=4

A AK~OBEELZBTH-0DI1C, L TOFIELZFEITTHE0C, EBROEREZA7ICLTERI—R
AWML ET,
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DA A —L

BRI R — 2O RIS TS OB E AT TSN, BEm DOV —= I3k OF
g% F24T7 L %9,

1. BTN TSR ORI ELZEERELET, BIE XRNVDT A AT LA B EDIT RN E
NTHEBFELTLIEEW

2. KCEOBEZZOENNAEE AL CTEEEOENEHELET, 75% A 7 0L« 7 b a— L KRR &4
HALTTEE,

A TR WAL F G AN LN TLEan, AR ORI EZ GO TLBZNRHYET,

BWBEOERZAICT S

1. BEEROBER SR AC B —
REERLET,

@ o °

® o °
(==
= @5 =

9. B/ DT — R B AR
T, B OEIRZA LT,

B BB TARNIC. VAT LD I T T LT A =T T AT LDYANT < F 4 AT+
o RERL TEEW, BRITIIA XL —FT 4 7V 2T LDIVARNT AT 4 T IXRIEN T ER A
TR =T AT VAT LDYART « T 4 AT DVERIZ DWW T, IROFERES R TLIESN, (11 ~_—
VARV =T AT VAT DDYVARNT T A AT DR B ),
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MDAV A—IL

HWBROEREXTIICT D

1.

2.

B2 SR DT — R E L
T, ama s vy MU LET,
R — A REH LT DB
PINDETH 30 B9,

(0 M|
3¢

pn-(u
wrli(‘.i
@ o

Beds DEIRZ BRI 7T DI
. vy MU FE TR BT —
REHRVILET,

Windows 1 37z —R " HAESL>Y
LR 1T Microsoft #£0 Windows A% 7 = — R %&{HE L TWET DT, Excel, WordPad X Paint 72 & D
Windows X—ADT FVr— a7 7B ATEET,
AR ORI B L RIETBENRHVET O T, AR —T 4 T VAT LEERTHT L8 T
TEEW, L TFTOHTARTAANINES TLIEE N,

Control Panel ONEZEH T AHLEXITFOICEREL TSV, MR D72\ 545 1%, Control Panel
ONBEEEF LW TLIEEN,

VAT LT MEHIRLIED  BE LD LW TZE W, ABER DO FRICHEL KFTTBE N
HYVET,

Background, Appearance. Effects, Settings 72& . VAT LD R IR T O NRT 4 Z BT LIRW TSN, 1
FROBNEHERCZ T« ATV — NI BE RIFTBENRHVET,

Windows 7 # /L& =X° Program Files¥Tektronix¥AWGYSystem 7 /v % O NK#EFE LW TLIZE N,
BIOS D% EA AR LRV TLIES WY, BIOS REAL T T 58, s RIEROEEIE EEL RIFLET,

Windows A Z 7 = — ADBIEIC LV ERIZEENREL TWAEEDbINAE 1L, Tektronix DOV R —hk-
B H—FTTHEHELIZEN,
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DA A —L

. 3=

RYRT—O~D R
A% Ry NI — 7\ L CL BRI, 77 ANVl A F— o b T 7R E O REZFIH T E T,
SR =71 L CHERR AR ET DT, Xy N — 7B E ICRIWAE Y, %D Windows = —F 1V
F o AL TS, GPIB, LAN O3 FEI2IX, System A== — GPIB/LAN Configuration & A7 1/ -
Ao A% HLET,

GPIB/LAN D& 5E

System > GPIB/LAN Configuration % : )
BINT AL H TS R 7 AN GPIB/LAN Configuration @

SnET, o
1. B2 GPIB NAa3a=fr—3x @ TalkiListen
YERELET, Address: |1 v/
R R e 2
vha— L UET, VX1 Server (LAN)
" OfBus- fik GPIB /S A% e e v Eee ek ey

9. AHESRIE . VXI-11 Server @ LAN @
Bz R —FLET, VXI-11
Server D AKX —h/ Ay 7%, #A

2« LA VXI-11 Server Control iR socket Al
FEALTTZEN, (®0n  PortNumber: 4 000
3. TCP/IP 7mhanb ¥R —hSivE O off
T Yy NEEOAY ) T3
ZCarta—LET, R—rEE [ ok ) [ Concel ) [ Heb ]

IE 4000 ICEESNET,

Bk

B OEREAREICA BRI VXI-11 Server & AKX — W72 55 1%, VXI-11 Server Control @ “Start
server automatically at system powerup” ZF =7 L TLZEVY,

B LUF ORI GPIB XiT LAN Bt bIdEIT TEERA,
= W
- WIEOF AR, ZRIDLEF
= BEO7+—~ v NEH
= AWGH000 > U—RX/AWGT000 >V —REET 7 AV (¥ AWG) NHDEIET — X DAL R —h
= Tektronix DTG5000 >V —AXD7 7 A )L+ AR —}
= Tektronix AWG400/500/600/700 3V — X SEQ 7 7A /L DAL R —h
- WET —ZDT I AR~
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JE—FPC ZRALEHEFEOIFO—)L

Windows @ Remote Desktop #HEZFI 352 T, LAN 28R B L T, BV PC Z2F|H L THEE IR IE
B —FEar b hn—/ L CEET, PC DAV —U PABGRIVE REWGEE | F—R—he~vU2&FI AL
TV RIREIEEEITAET, £/, PCITAV ARN—LENTND Y — RN —F 1« VT T =T Zffi
THEEIERL, ENE XN —JRBETAV R — 52 TEET,

2542 -F—F

FTTA e T—RENT, RO T TV r—varwBEWD PC ETEITSEIMETT, 77V r—a
V% PCIZA VA= L L TLIZ& W BEER D ARAR N =R 2 T IIARE T, IS DR T 7 7 AV DIERR B X
OHREDFIEETT, PC TERLIZ 7 7 ANV EDOBLIZE A CHEATEET,

1. % %D Web H Ak (www.tek— AllPrograms ™| fF Tekironix A Documentation ¥
tronix.com/software) T AWG 4 i, — [ sws
VIR 2T DEF/NN—Taws E| Sea s @| S ] awe Config Utility
vrm—RLET, RIS T,
AWG 77V —ar% PCIZAY
AP—=/LLTLIEE W,

2. AT7TA = REME T DENIC,
Mo 74— a BRE
THVLENHYET,

Windows @ Start A== — 75,
All Programs > Tektronix > AWG
> AWG Config Utility Z &R L T
Configuration Utility # A7 127 « iR

I AR RLET,
3. ;“ﬁﬁﬁ@%‘é%ﬁ@%’f%i&ﬁﬂbi il Guniiiais o il
4, TR OMEROF T a R IEE

BELET,

5. OK 227Uy 7 LT,
Start A= —OiEEROT 7V —
varzE#E 4 5L, Configuration
Utility DX ENE D RKMEIVET,

Definition of Option:

01 Memaory Expansion to 64 M

02 BExtended analog output handwidth

06 Interleave and Exdended analog output
handwidth

08 Fast sequence switching

[ ok ] [ cancel | [ Hep |

6 AWG5000 & AWGT7000 V) —X DAy RB—kA—H -7 =a7I)L



HEORE

P AR OMRREZMERR 9572012, 2 OB —F U R ESTOVET,

B RU—F LT T AR - AR

B System A== —MNHDBWEAT -

1. A==—+/3—» System > Diag—
nostics... ZEINLET,
Diagnostics Z A7 07 « R 7 AN
FREINFET,

2. Loop BT = Z7E N TWRNWIEE
B LET,

Loop MF =y Z7INTWNHE, Tl
TIEIESNDE TR BB IS
7,

3. Select All #27VUvy 74 25L, 2IHH
NTF v I7ENET,
PHBOZWE LD TEITTD
&b, BIRLIZEE OB OZ K%

EATTHIELTEET,
4. Execute 7V 7 95L, ZWiNE
TSN ET,

TT—PNRESNRNEERERRL
T, =7 —nEINLHGAEIE.
Tektronix O —¥E ZAF T EH#K<
7230,

AWG5000 $ & AWGT7000 1) —X DAy RA—hk2—H 3 =27/l

BIRHE AR B L7 T AR EITLET,

UTFOFIEZEITLET,

System Help

Run
Stop

Channel Skew...
Interleave Adjustment...
Force Jump To...
GPIBILAN Configuration...

Calibration...
= Diagnostics...
Service Mode...

@.

Preferences...

Option Installation...

DA A —L

Diagnostics
ftem Status (Eror Codes)
Front Panel Pass
[Z] A G
Redgister Read Back Pass
Ch 1 Wawvetorm Memory Pass
Ch 2 Waweform Memory Pass
[¥] Clock
Pegister Read Back Pass
PLL Lack Pass
Output1
Reaqister Read Back Pass
Analog Level Pass
Marker Level Pass
Output2
Reagister Read Back Pass

[] Analog Lews Pass
Marker Le: Fass

[ selectan |

4

Execute

[j Loop

Clear Al l Configuration

@

Result

Pass Count

0 |

Fail Count Reset

0 |

Close ] [ Help 1




MDAV A—IL

BE&RIE

HOREZ, WS —F 7l L~ — - LUV EDO BRI EETF = /L, &4
BN UNE IEC R AZHELET, ~— B L ~ULid AWGT000 2 — XD F =7 ENET,

H: AFNEZET T L00C, MEOERZ AN 20 HEA L OFEICLTEBIET,

1. BEZXF/LD Run RZ U B4 T7 D

RIECTHHZLETRL T, 12 B (run) @

HAESN TV RN iR LET,

2. WIEZFATTDITIE, A=a—/3— @
735 System > Calibration... & 2R
LET, Galibration X
C_alibration 5'4’7"37'*/77\75‘43—% Itern Status (Ermor Codes)
FENET, ' [ Analog ' '
~ Ch1 Pass
3. Execute ZiBIRL £, Ch2 Pass
b arker
Chi Pa
Ch2 Pas
Execute | [ Cloze ] [ Help

4. MAjaxr2IcHEmS TS —
TNERONT a2 BSR4 4
Ty Ry I APRFERSNET,

5. /7,._7“/1/7%@@571\[/\ OK %j;qal/i | u(% | =
T, RIEDE T THETRHLET,
TI—NEESNARNI A HERL @

FT, =7 —nEINHEAEIT
Tektronix DY —ERAFETTH KL
720,

AWG7122B

E: A ORETAZREESRME T TRVEIELATORER A, @ <=V TEI{ED T ] Z),

HE: AWGT000 2V —X - 7l BLO~—b DO L XV OMEZHER 7572012, 1 » A2 1 EH
O EAZEITLTREEN, EITLRWEA . 7T/ BLO~—HICEL TRIFESH TODHEREL X
VBRI ERNZENHVET,

AWG5H000 >V —X = 7FuZ ML)V OMEZHER 7572912, 1 121 FHORIEZETL TR
éb\o
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DA A —L

BEBEOREN L
BB R 1 B

AT B B RE 2 H D MR O NI E N TSN E T, mEREZ B T 5L, IROEIENRFE
ITanET,

B OESEANEIEE N LIWVMEZBALEEE A=V REIRSNET,
B OEBRORENSHIZ LRI L ARBITHBNIC vy MU LET,

BEA T —URRRINID, KITER B v o MO LG E ROFNET =y 7L TIZEW,
@ ~—=v TEEDEM] ZH]),

B IR E ORI CHEAIN TV,
B TEORESME (ZVTT70R) EiEL TND,
B RO NIELLEIEL TV,

HAhaxo4

ABELR ORIHE S FMT, B Oaxs 2 AT Oax7 23 HESHLTHET, (5 5=
R 2RI D DAF B EIMA RN TIEZS W,

Channel

[ Channel

" Interleave——y, — — —
Ana Ing A alog Analog Analog Mkr 1 M1 Analog Analog Mkr 1 Mkr 1 Mkr 2 Mkr 2

@%ﬂ@,@—Q 86 8,60 o6 o6 ©.06

DO NOT APPLY EXTERNAL SIBNAL

HARIRIRIZHMED saJ_éiJl]zt;L\’C(téL\
BETRETIENNHYET,

BE: B axs2cr—7 Ve ER TR T HA T, W TEERBERL —2DE 5
EATIZLTLIZEW, 5 H 1034 DR RETHMEREESZS (DUT) 2826t 3oL, A< DUT (ZHEE%
B z22Z2E03H0ET,
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AT DA A—IL

Option Installation %' A7 127 « 7R 7 2% LT, Tektronix 7O A LA 7 v a Biga AN TEET,
T OF T g DYANMI DWW, www.tektronix.com FE72 X Tektronix fSHRE IZB WS bR LZEN,

1. System > Option Installation... %3 ) ) ﬁ
R D8, FAT T R 7 AR E Qption Installation L
RINET,

9 Conti DY R H Tekat/G Option Installation

. Continue b4 NV
DEALT TS ﬂfyﬁx NEREINE Jze thiz pragram ta enable Dptional feature and

external applications that are awailable for pour

7, instrument,
Tektronix 2HHEEINB AT 23 You must have a valid Dption [nstallation Key to
S o A g e inztall optional features and external applications.
- /]’/XH/\ 7/5{ * 753&17% For information about purchazing an option or
T, AT )—> (\—?fméﬂ%)*a N application and obtaining an installation key, refer
ﬁEI, AN FFar AL A— L LE ta the Technical Support infarmation that iz
+ available in the Help menu.

@f | Continue I Cancel Help

T A7 var = ANK BEICA T Va2 TR T 21213, 77U —varz ik s
THMLENDHYET,
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FRL—FA4VT D RATFLDYVANT TR DERK

ARL—TFAT - RTFLDYANT TR DERK

ZM}&%”” IFVART « FAAZ IS BLCOER A, RO FIEICHES T, —BHOTF A A7 E/ER L, SE72
BIEANRL =TT VAT DEVARNT TEHIITL TS,

c EE: AR —T AT VAT LEVARNT THL =R T A AT RIAT I/ 7+ —~vhShET, 1SO
A A=V G —Y T —Z T LbivET (Acronis Recovery /N —T 4 ar BIOBEE 457 — X3k
EINFETA), AN =T T VAT ADVANT BB DHEN, AR —T 4 T VAT B YARRT

T AART BB L TS,

H: ZOFNETIE, Microsoft Windows XL —F 4> T« VAT LD —@BDOYARNT « T 4 A7 ZAERKL %
T AR =T AT VAT LEVANT LB T s D7 S r—a < Y7 N =T A Ah—1 L
F9, BD Web 1k (www.tektronix.com/software) TF7 U —aL V7 =T 52X 7 a—RL ., &
RIS THA L AR— L L TLIEEN,

JARTZ T4 R DERK
#l: koborHABELET,
B DVDER/W RIATBLONCD EBAARAY TR =T fFEDa B a—H,

B AL B2 — 2T ISO A A=V T 7 A NEEEET DD USB 7Ty 2-R747 (8 GB LA
)| E2iE LAN BB,

B DVD-R(DVD-R/W RF[) T4 A7 HI 2K (NI T T T 7 A NOFIZIKD 72D FET),
—#HDYART CD-ROM ZERK T DL, RO FINEZFEITLET,
1. 25 EC. C:¥backup 74 /VZIZBEILE T,

2. USB 7Ty =2 RTA47 /=13 LAN Zf# L T, restoreN.iso LV X FIDE T 7 A V&2 2—4 (CD
EXIALFEREST X) ICEEELET,

3. DVD i%)&ﬁ/7]\'717%ﬁﬁﬁb“( N7 77T ISO A A—« 77 AL (restorel.iso~restoreN.iso)
% DVD ICEZIALET, & DVD OTX)UZIEINRN I T v T T 7 AN ams DA RES VT VT 5
BLOH H’Euﬁ]\biT

4., OS DVART « T ARTDEZALBPK T LG, NI T T HICT AAT A A=« T 7 AL (k.iso) &
Fy R —7 EOEY7RIGAT, IO N—R T 427 HAT 4T 2 Iat—LTEEET, (D OS
FUARNT TBHE IO NN—R T 4RI LD SO A A—VIXHEESNET),

5. Ny U7 7 TAAZITHRBE ITHE > THRE L TITZE N,

T VANT AT A A3, TAAZERRIFICH A LI R TO B AT,
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FRL—FA4VT LV RTFLDYANT T4 R DERK

ARLV—TAVT P RTLEVANT TS
IR DOA XL —T 4T VAT ADVARNT L BEERDN—R e T A AT RIAT DT 7 AN, FT21LFD
BERDO B DYARNT « T A AZIPBATWVET, (11 = [VRARNT - T4 AT DIER ] &8,

c BEE: AR =T T VAT LEVANT T oL N—R T AR FIATIEHF T+ — vy S ET, ISO
A A=V HhEda— - F =T EbET (Acronis Recovery /S —F 43 ar BLOEE T LT — X130
FEINFEAL),

JRART TARIDDDARL—F AT AT LDY)ANT

H: ZOFNEEETTHIZE. DVD RIAT B, mUNTEENTH5T SAAEL THRESILTWVDLENRHY
FT(TT7HNLFDOHRE)

E: VANTHTAAZE, TAAZERIRICHEHA LI TORAZH T,

1. UARNT «F 4 A7 1 Z¥4585D DVD RIA 7\ AL E T,

2. IR HEELET, DVD RIATNRYIDOT —h e TNXAZTHIVL, VANT 7 07 N H BRI
EEILET, DVD RIAT BERPIDOT —b T AALAZATRWIEEIL. TAARINEDIANT 2 F1T 4 5Hi
W RO T — R F AL AL CHRETHILENDHVET,

3. Restore 27Uy 7L %9,

4, WERDOEATY <Ry ITANT Yes 7V 7L TANRL —FT 407« AT LEVANTLET, £7213 No
PIERIRTALUARNT - v A% TLET,

5. RIRINDAY =V THIEDYARNT « T4 AT IL , BRENTZT A A7 AL ET, Z
NZVART T aEANTET THETHIIRLET,

F: VART - 7avA0@ Y, 7al L R R—=RN8nlR 2083 B0ET, UL, TAAZ - RIALT DT
UM EBRUEET T IE L VART e AT LTV E T,

B UART <o ar Ol VART « 7PV —a By hO R HIE T DT A AT ZA0 K
LIFEEATAIYERLTCEXET, ZHUTVARRNT Ty — 3> D IEFEREIETT,

6. UARNT - FREANET LIS, BB DYVARNT - F 427 2RO LT, #ama FHiE®s L E7,

7. AWG 77V —var Y7 =T E A A=V LET, Y7 T 524U a—RL TR0
Bl Bt Web YA (www.tektronix.com/software) CY 7"y =T X 70 —R L FERIZHES THERS
I =T A AR — L L TCLTE &Y,
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FRL—FA4VT D RATFLDYVANT TR DERK

BBON—F-FTARIDDARV—FAVT - RFLEVANT TS

AR TIE . N—F RIALT DORIDR—F 42N R —F 4L T VAT A UANT 7 7 AV iN S E
NTWET,

1.

Bz mEELET, 7= Ny T DOBRBHE TIROAYy =V BRI — IR RSNET,
Starting Acronis Loader.. press F5 for Acronis Startup Recovery Manager

Acronis True Image Tool 3B ET F5 F—%MOIRLHLE T, Avb—UNEXREINTHLERTD
FTIZK 5 BRI ET, Acronis 77U —al NN o280 RO EFR LA 712 C
MOFEA AL T, b~ ERVELTEEN,

. Restore Z#7VUy 7L %9,

WeRBDLAT T IRy 7 AT Yes 22V LTI DA XL —T 4 7« AT L&Y AT § 570>, No
IV LU TYARNT - 7o 2% T UET, UARNT - e RI23K 10 I EZZEUET A, FEEITN)H
DTSR DR EIZ L > THRRVET,

AWG 77U —3a VTN 2T A A=V LET, Y7 7T %2 F 7 a—RL TN
AL, 45 Web YA (www.tektronix.com/software) TY 7 =T X 7 a—RL ., 8RR ICHE> TR
IV 7R =T A Ah— )L L TLIE &Y,
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BIE /SR

BIE/\RIL

WDOKIEL, AWGT000 ) —ZDESED 7 ke SRR LA R L TOET, AWG5000 U — K D RS [ KE

14

‘/C‘j—o

AWGT1228 Adbitrary Wavel

-

BIE/SRJL-aORI4

2%

Wi

1. Interleave Output

A BAY—T eax 2 F, 12 GS/s ~ 24 GS/s LT Ful
B2 HILET (AWGT000C S V—XDFFa 06 Bl B
FONAWGT122B BlD A7 =2 06 D7) . AWGT082C il o>
F 7 a 06 BICIL, 8 GS/s ~ 16 GS/s DL b E4,
QR I HHAT: SMA

2. Analog Output

TrusEEER I LET,
AL HAT: SMA (AWGT000 ) —X)
ARy H A7 BNC (AWG5000 U —X)

3. Marker Output

~—AfEEEHILET,
AR gL HAT: SMA (AWGT000 ) —X)
ax X B A7 BNC (AWG5000 U —X)

4. Trigger Input

SN G BE AT TEET,
axyHH A7 BNC

5. Event Input

ARVMEFTEANTEET,
axyHH A7 BNC

6. USB 2 S® USB 2RI X W EiH /S R/MZER S TVET,
USB 7 A A& R TEET,
7. DC Output 450 DC BEEEZHNILET,

aARTHHAT 254 mm 2 x 4 BV e~ F (AR)
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)7 - /82JL (AWG7000C ') —X)

HE: EEHNaxs2r— 7‘/v%§fﬁtitﬂ&@%ﬁ“iﬂé\bi\uZ\?“E%?iEZ%JE“Z\V*&@%%HjJ’J
EATIZLTLIZEW, [E 51034 DIREETH MRS DUT) 28k 358, Afs<° DUT (&%

H2HZENBHBVET,

7 - 75%JL (AWG7000C 1)—X)

@

@0

EOE @2 |
@6 © @Qi

O O

@)
i

EDE

oo

=0

o]

e ©

@ (8 @5 (9 N

H: AWGT7000B 2 U—RXDEE 1L, BARHMEICFEEROIRXIZNBHVET,

aAxy L

%lﬁlé

B

1. Bv4hL [ fEZ: HDD

ORI RERN—R T 4 A7 KT 47, HDD Z#E 44 &,
YO RNT T T AN T — X E O —FERIIEIRN
HIZIEEVEE A,

2. TekLink T —H+ A" —Nf TekLink 274

3. GPIB gL GPIB o he—J %85kt 95 GPIB 274

4, PS-2 v~URAfaxsX N AT AT D PS-2 ks H

5. COM2 DT NARZL YT LR —MER CHRT 2L HT5

COM2 T YT LR —h

6. eSATA AR —h

SRR SATA 7 /3 A AZ B BT B L X (T F5 eSATA
H—h

7. W7 ay 7 AR —b

R a7 AR — M3, RS 52 OSER T S A RIZEAE
FTHIOITHEALET, MEARHITIZO=a R 22/ mL T2
Sy,

8. LAN

W an% 2o NI — 78k 5 R]-45 a2/ ¥
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)7 - /82 JL (AWG7000C ') —X)

16

2k

A

9. PS-2 ¥—AR—FK-axs¥

PS-2 — R —REHEIR I8 95 PS2 a x4

10.COM1

LR E VT L R — MR TR T HEEIEH 35 COML
YT LR —h

1L.e7 AT A2 o 7 BB O =2 OBERHE T % DVIFL e 7 A
A —T, VGA E=4% DVI-l %7 2T HIIE, VGA-DVI
TETHEfERLET,

12.USB USB 7 ARG BREL £

13. 8 A4F Iy 7Py T e axsZ 15D DSUB X IEZEHEHL T, T—T NPy FLeFn

WCEEDBED BRI E BV IV X 2l RElc LE T, (AWGT7000C
) —X)

14. External Clock Input

FoL—2 AJJHaxs#
IR HHZ AT SMA

15. Reference Clock Input

NEV TRy NJJHaxs#
gy HH A7 BNC

16. 10MHz Reference Output

IOMHz V7 7L v R a7 E B H haxsz
axyHH A7 :BNC
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)7 - /82JL (AWG7000C ') —X)

BAFZIYH- DT A2 -aR9%(AWGT7000C 2 1)—X)

AWGT000C V=X DR DIGE VT RPN IE AT I T DX T oA AR 7253 HY, 0.0V ~ +5.0
VIDC+E—ZAC)D TTL VNN EHEZITANET, 5 ZAT DD axs2xEHLT, Vv
oA NE BRI L E T, ST 1 AD RN —TERE 8 KDV S ALEREZIFANE
T, ROKEFIL, ZOaRxI O #EE R L TWVET,

8 1
@ \ OOOOOOOOOOOOOOO / @

15 9
vUERE (ER 75 1A
1 GND
2 Ty E Y0 AN7]
3 Ty 7 Evh 1 ANT]
4 Ty B b2 ANT]
5 Ty 7wk 3 AT
6 GND
7 AlE—7 A7)
8 GND
9 GND
10 Ty E b4 ANT]
11 Ty Evh 5 ANT]
12 Ty T E Vb6 ANT]
13 Ty 7By T AT
14 GND
15 GND
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)7 - /82 JL (AWG5000C ') —X)
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2481002

ORCOO)

#: AWG5000B vV —RX DAL, BARDMEICFEEOIRIZNBHVET,

aksH

wi A

1.

w4k el HeZ: HDD

BOALUR[EEIRN—R T 4 AV +RTA7, HDD ZEWV4 3L, B b T v
T T ARG T —H 8 Do — PRSI SENEIZIIED EE A,

2. TekLink F DAL R—IRR, AT ar 09 B TTL A~ % TekLink LVDS
ARTH T T H R 7 Az T D TekLink a2 17 ¥
3. GPIB GPIB O AED - 1 2H# L GPIB i b —F &35 GPIB o7 &

4, PS-2 ~UAflaxsH

VU AL ITHRE TS PS-2 Ak X

5. COM2 0T A RE YT L - — M CHEET LT % COM2 &
U7 e R—h

6. eSATA 7R —h SHERD SATA T /3 A AZHEAR ICHERE T DL XTI~ eSATA A —h

7. LAN 3% Ko N — 2 ST B RI46 R 2

8. PS2F —R—R-axr¥  PS-2F—R—RaHafITBkid 5 PS-2 axs4

9 COMI D88 % 2 U7 L K — MR CHERE T S L E I T5 COMI U7

JU e iR —h

10. 8574 TR T ATy 7 EER OF =X O8I A 925 DVIFL BT 4 <R —h,
VGA E=#% DVI-l ax 7 X228k 951213, VGA-DVI 7X 7 % %4 H
L/\i—a—o

11.USB USB 7 A AR LET,
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12. Digital Data Out

TN T —HOH T axs R, TR T — XTI EITHITIE,
AWG5002C ! AWG5012C B . AWG5002B B AWG5012B B |c A7 23
VO3 UAEA AN THLERHYET,

apxyHH A7 :SMB

13. Add Input

g 15 B HVERE B2
apx g HH AT BNC

14. External Clock Input

Fb—Z AT a4
gy HH A7 BNC

15. Oscillator Output

T —2WH I Haxsx
ax K H A7 :BNC

16. Reference Clock Input

YT 7L Ay s NS Ha R Z
ax M H A7 :BNC

17.10MHz Reference Output

10 MHz V7 7L > R rav g5 1axr#
ax KX A7 :BNC
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HaRDHE

avkO—)L-/\RJL
® S S

| D
Q= = =0 o

uwntcmgms I )
[ Level &~ ]

0

POWERING DUT.
Amplitude

@ o oo w ®
@ @2 8 wa @ G @
@ @ o o a @
| - @ o G G
3) @ @ ® @ @
o (ﬁ = s BB
an a2
RE ) F- B!
1. Run Run AR 2 N3G B3 ABEDORME / Bk 2o ha— L LET,

fE B BRAELTNWDHEXIL LED 28T LET,
E IV S /N Y E R g s DAkttt s S TN TR VI
All Outputs On/Off R Z >, F721Z Channel Output On KX %
L TH N EAZ—T VI THNERHYE T,

2. All Outputs On/Off OEDLL LD NINBA L DEZICZORZ T L T XTD
AN A 71220 FES, X TOHIIBNAT7DEEIZZDRE
T L T ARTOH DB AR ET,

3. Channel Output On Fxr XN OF ) FT75GEZET, R A L oNREE
DOLELED BAAMTLET,
4. Channel Select F o RIVEINR L AT BIEORI R /2 DT v RIVEERINT

HOWAERLET, B SRV DT v RVBIRRZ RSN
%k, Settings VA RUDKIET DT ¥ RN DX—VINT 7T ¢
2RV ET,
5. File — Open/Save Open F721d Save RE NS D L, JIGTHXAT T Ky
IAMF RSN, BET7AN . AWG) 22— R E7ITMEENT
=FE9,
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it kg

6. Factory Default CORZ T ERRESNIZT 74NV EREN SN ET,
AT =2 [FT74 )V RE ] BHR),

7. Sampling Rate ZDREZ L ERF & Settings VA2 RD T Timing X —Y O

Vo« L — b DRTA—=ZPNRIRENET, o7V 7L —NE
KT v @Y,

8. Level — Amplitude/Offset ZDORZ L Settings VAV R TS T5F ¥ 1D
Amplitude F721% Offset D/XTA—=FNEIRENET,
RIEIXE T v RN CTRBNIE ETEET,

9. Marker 1 B X Marker 2 -  ZORZUEHT L Settings VA RUTHYBTHF ¥ RO
High/Low Marker High F721% Marker Low M/ 3T A—Z N @RI E T,
Marker High & Marker Low 134T v LV CEBNCER E T F

‘é—o
10. Touch Screen Off By F ATV —RERENA L DIRFED LE | FRIEROARFAT A

B TR — e Z T — A ar fa— L TXET,
By F e RTY—2 N F 7D LED ST LET,

11. Force Trigger ZORF T NENTE &2 AELET,
12. Force Event ZORF T E N AU MEEERAELET,
13.ILH /7 IO, REWA ST, Ry T Ty T Ama— T L

B Ama—  KZIFAT T Ry I ATT AT L@ IR
LOMERSNET, /7 2R FHEI B LER L KR
FHEI IR LA LET,

14, 78R — HOBRIR KA — 1%, RETA— VR TCHTFEE T THEEXOH B
BCERHLET, e AT/ 7 EERHLET,
15. Ml A J7 3% - BN AL A B EREES— (T/p. G/n. M/ . k/m) ZHf

3L Enter ¥ —Z 3L/l a M T CEET,
BEREBOHGEITT (77).G (FH) M (X)) k (1) LfF
REnEd, FEOHAIEp (BE2) on (), u (wA471),
m (V) LRSI ET,

Q EE: BRI SRVDESH Iz 2o R (DUT) 284t T2 &%, BT AR OE 5 H %4
ZIZLTLIEE N,

ARER OE FH A DAL ORETIE ARG OBIRA Y/ A7 21T\ TSN,

BIE/SRJ/L-arvka—)Lonavy / avH Rk

EERTEE R —ZORTHE 7S %/VIE. GPIB =2 Ethernet TUE—MEESN TWARIICEY ZENAEE 1 H
DET, BTAIAS IR 7ENTWDLEBIFEAA v F Z BT N TOF —0RZ NI H TER<R0ET,
T IARF — R —Rbffi I CXEH A, 727750, Bl SR a2 EE T Windows OE{EIZATRE T,

AT SRV arvba— L Ouay 7 EfRRT 51203, VE—h-a~  REMEH 3220, £Ea0HE S xLro
Cancel RZ L% 2 AT CTHLET, 77Uy —av a2k TTAluy 7 REEIIMEENE T, BT 7Y
g—varzEE LA, fimo s videy ZERS TV ET,
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BYF RPN =20 AV AT—R
EEWEEERL —F T, A2 —BIROEDIZ2 >DOFESHES L TWET,
B FifoS gL earie—L F—R—F, B~
BN LA e L e Ry F R = e U H T 2 R

1. A/ 3%V ® Touch Screen RZ _—
EFILIZED, Ay F AT S
BREDA L AT HUIVEZDILE - @
R
F7 OIRHEET LED 8 AATLET,
ZOWRBETH A —L DA=2—|T
I~V AEIIF—R—RTT 7%

ATEET,

p g

T A k7D Calibrate Touchscreen 7 A2 %7V 7 LT, Xy F ATV —U B TEET, (22 =V
[Elo Touchscreen 7 7' U —al | &), U TOLIREEIT, T - AJV— B RETHLENEL
7,

B AR =TT VAT AEFA ANV T D
B N—ReTApAT - RIAT T DH
B Xy F AT — PN YNT KSR

Elo Touchscreen 7 75—, 3>

HoF e AJ Y= SO RIENR R AE LA . £9 Elo Touchscreen 77V /r—arnh, ZyF« A7
V= NIEELGBIREN TWBANEIDERL TLEZEW, U TOFIET, ELVEBIRICETZENTEET,

1. Windows A% —h+A==2—7/ 5, Control Panel Z %R L £,

arvha— L XD, Elo Touchscreen 7 A2 %X 7 NIV I LUET,

Properties 1 %7 . Advanced RZ > DINEIZ 77U ET,

Edge Acceleration ¥ —/ L C. Enable Edge Acceleration 2N BIREN TWAMNEINIER L £7,
OK #27Uy 7L %7,

Mode # 7 %7 Vv 7 LE7,

Calibration £ —R"C, Enhanced 23 REN TV DO EINFERL E T,

OK ZZ7VyzLTarba— LML ET,

7 AZ b7 @ Calibrate Touchscreen 7 A2 %7V 7 LT, BEXyFAZY) — 2L E T,

© ® N > o s W N
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L AWGT122B - Setup13. awg

efined

WFile Edit View Settings Tools System Help

juence

HEROBE

Farce

Total Tim

Current : 1 Running :

I|I| IIIIII I"IIIIIIII| IIIIIII IIIIIIIII| |||II|III IIIIIIIIIIII|"IIII||II|IIII| i ll ll“ I I“ I“““ !“ ll III I ‘ ‘

III IIII IIII III III II“II I III III III II IIII II |I| -“ II 1II N II ! I l h l II

€ € € ¢ € € €

Ch1
Output

Amplitude Offset

[ 0.700 Vpp -0.250 V

om_

Filter

@:oav @: 0s5v
AC:0 Pis [
1

Point: 933 Pis WVaoltage:

s

| &
B R R

0Pts capos: |

DAC Res (bits)

Marker 1 High
1 o8 @10

0.80 V

Marker 2 High

Marker 1 Low

. -0.20V

Marker 2 Low

Marker 1 Delay

Marker 2 Delay M Direct Output

h emote Command: AWGC:RMOD SEQ

A7V =V DT A i B

1. A=z —3— Ama—  N—OIEER O T X TORRICT 7 EATEET,

2. AT —HR/N— AT = HAN—L YT VT L= BEE—F, A
TR AR E DO AR RE R RLET,

3. Waveform List 742K Waveform List (ZIZ2—WEZRFE K LEHOLN U E RSN IF

DYVARRHVET,

4. Sequence VA4V R

ZOT4RUE, B = AT A AR R LET,

5. Waveform 74> Rt/

D74 RZiE . Waveform List F£721% Sequence VA4 KT
BININTZHERFE REINNET,

6. Settings VAR ZDOTA4VRINE RIRA—HBE~DIA T T 7EALLTH
BENTWET,

7. A4V R 2T BT h oI HE MIGT DU R DER [/ FERREYY
Rz ET,

8. UE—h-a<wr R — BIEOBISBRIEICKIGT AV E— - avwr RRERENET,
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BEEERL—FBEOERRTYS
AR DEIRBARL ., T 7V r—arDA=a— N —=0ar b — )L R 2 AL TR EOIER B X
ORELZITVET, 26 X— [Ama—BIRarha— L -4 Ry~DT 78 A IR, UTOXTy
T -> TR L E T,

1. Ly FuZEEaElRd 21 Edit View Settings Tools System
{&. Edit > Create Analog Waveform o o
RN ET, MERS NN o )
Waveform List V4 RUIZEREN Redo Ctrl+y
i‘?‘o Create Analog Waveform...

Create Digital Pattern...
Equation Editor...
Cut... (:lrl+)(mrOOA

2. MAEFOWIEELEN T 2121F, F;algj File Edit View Settings Tools S
> Open File... TR E7 7 A /%[

% Wavelorm Lis ! b o | FactoryDefault Setup  CtrlsN
LTHhHIEEEBEIRLET, e_° Open File... Ctri+0

Save File Ctrl+S
Save File As... F12

3. EMEE—RNZfERLET, Settings

]7/( ‘/]\“17 0) Run Mode A \‘/“"C\\ . Ch1 Ch2 Timing | Run Mode | Trigger | Event | DC Output
?ﬁ‘ % ’a_ 5 é}] 'ﬂE:E‘ — ]‘\“ ﬁi‘ ig ji)_\' é j’L < ?\Cominuous ® Triggered ® Sequence
I—'—l

WHZEZMERLET,

4, EEEFRAESELHITIT, BiHEF
L0 Run R | ET-IZAT —H A C—@
sX—@ Run RZHHLET,

5. WOWTNEFEHALT, Fri =z
IO HEF I UET, AOUtpUts  caumioN

@ B CoAnee

B R %/ O Channel Output SONEAING BUT

On HR¥ 2 F7=1% All Outputs

On/OIf 5+ )

B Settings V42K Ch X—T D

Output On & W
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Run £—F
EEREERL —ZIZ L TodEE—RE2Y R —hLET,

E #E(Continuous): HiFiL7-ENH HENET,

RJAH (Triggered): NIHEEEZELIEXIC 1 SOEFEH HLET, AT HLE%IZ, KON
TEFFHFLORIEICRVET,

5 —M(Gated): ¥ —MEENEDRIREDLXDOL BN HENFET, 7 —ME B NA 2h7e i iTE ks
L=l n i h&nEd,

—4r A(Sequence): ¥ — 7 U ATEREINIZNEF I TEBOBEENE HENET,
Run &—RZ. Settings V4> F7® Run Mode ~X— TR L FJ,

1. @fFE—Fa@RLET,

2. ]\ U ﬁ - — F‘ k/?l\__ ]\  E— ].;‘-*C\ &i . r -|1 Ch2 | Timing Rm/cﬂoue Trigger | Event | DC Output
]\ U jj‘?%“: ‘E 0) ){jt'z‘a\"c“ O) Hj jj 1@%1@*}{ @ Continuous o(uTri_ggemd ® Gated L] Sequence
< OO
T % i ‘é_ o Output value for waiting state
’70 © First ® Last
B First - HAL~ULELTHIBO
DB AEELET,
B Last - HAOL~ULELTHIED
Rt DE R ELET.
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Trigger A bAO—)L

NITE, BHEE—RBNIT, 7 —b, =T RO EX, IR AIOFIEZITNET, NIT DT A—H1T,
Settings V4> R @ Trigger X— Y TR ELET,

1. *UA > — A (Internal £7-1% Ex-

ternal) Z®IR TExFETJ, T 7+ Ch1 | Ch2 | Timing | Run N Trigger | Event | DC Output
1% External T, —Snurceﬁ//%
. . . @ internal 0 External
2. External %R 5L FIH L~ oival ot Stope kmpedance

HUABBRETEET,

m Level - AR ORI T -~
NERELET,

m Slope - ARV EFEHT 5
L&, 3 BV (Positive), 3L T 9
(Negative) DEBLHD TV Th
U EINTBNERRELET,

B Impedance - AHERI T DA
B AERRELET (1kQ
F7212 50 Q),

3. Internal Z®IN35L NEN T D
NI TERENEETEET,

b BIARR— T B A L

ek
B NI DORTGA—E2N EBHDEWEEZa re— L UET, NIHT DT A—& L, BIfEE—RA Continuous
DEXIIRETEXETA,

B KRGV —ZATERLUZEZDIENIZ, HiH SRV D Force Trigger RZ L ZH#L THRN V2R A4 5
TEMTEET,

AZa—LU0arrA—IL-242RIADTIER

26

KAma—DavwrRRarhma—/)L U4 RUILT 78R T 50, SESFRFENMHBESNTHET,
1. A==—+/3—/»5 Settings 27V ~Settings Tools System Helf

JLTC, a<wrRE@ERLET, Ch 1 Level
IR 7-H H 23 Settings V4> R Ch 2 Level

TT T4 7 0ET,

Timing
Run Mode
Trigger
Bvent

DC Output
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. REA=a2—~Dva—rIvhel
. Settings V4> KU T&F
T,

Settings V(> K> C Ch 1 <X° Timing
DET ol 7358 ®IET5
NR—=UNERINET, e D
MR EERINTHOICHEHLET,

. HIE NSNS, TV T —
hIRIEL L A7 By b L oL
BLOw—F LUl DK /T A—
HREIZTIERLKT 7 BEATEET,
INHDORELD 1 OERFTL
Settings V4> R DxfIid 537
A=A PNRINEINET,

. NUADOEIZYy 7 CRE T A A
—a—HRBICH BT 7EATE
7,

7=& 21X, Waveform List V4 R
ETHEIZVy T HE, BHETHA
Za—RRRINET,

Ch1q

omp-N

Amplitude

Offset
1000 Vpp 0.000Y
Waveform Rotation

Sampling Rate

()

Am:lituda Offset

Cop =ty

(g 2 o )

\Waveform List

Output Waveform

Ch2 | Timing | Run Mode | Trigger | Event | DC OQutput

Marker 1Low
000,

Marker 1 High
1.00%

Marker 1 Delay
0.00 ns

Filter

Marker 2 Low

[ cwy
Digital Low

Marker 2 High Marker 2 Delay

[ sar

B

P

Export Waveferm to File...
Standard Waveform...

Delete

Delete All Waveforms

Copy
Paste
Rename...

Go To...

Waveform Properties...
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:phn—)béﬁﬁ’&%ETé

BE o ETHEEIT RIBL NARA T By Me L ORAENTA— LR ETLLENHVET, A7V —
e '74’/1\'7“( ﬂ%@/\7)‘ HHEBRET DN ZyTF TV 7L TEDNTA=ZZRIRLE T,
WO T IBRIRT DL ZDNTA=ZITH LT 7 AR ET,

AP VRREAE T LT, P/ 72 TEET . U PR RS GEICE > TORELZLE T

LHIENTEET,
u **ISOD/\7)< ZINE Ry T Ty : ]
SR EEF R R T L
[ A CE BB Db B0 £ | ool
X— R (FeldF—AR—K) 74
avE IV THE, F— 308 (F 7 8 9 Tip
72lEF —AR—F) BERRINET,
Set bo max 4 E] 5] Gin
1 2 3 M
Set bomn L] - i+ kfm
Cancel Bksp Delete Enter

2481005

m /\){7%57 &%ﬁﬁgjij ii;;\ Marker 2 High
= v
TRAEEEOHTIZEEIL . HTiER 6
F—EFEHLTEDOHDOEEE T
LET,
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aArvkA—I)L- D4 RO DRTUE

EEREE R —FDAZ) =L, T 74/VRT 4 DDavbo—)L -7 RyRFRENET, T4
U2 TEMERLT, KUV RUORT/ HRTRETIEOKOEZLZENTEET,

1. @]’VE%“‘FZ}ST‘/‘_‘&\/X@%%\ 5:‘ File Edit View Semings Toeh System Help - — —
TANVETIE 4 DD R | —
—fczﬁi\;{% éﬂiﬁ—o User Defined | Fredefined Total Time : 320 ns " Switch b Tabls

Currant: 1

Marker 1Low  Marker 1Delay - DAC Res (bits)

EID EXT90

Marker2Low  Marker2Delay g Direct Cutput

2. Settings #7 & 7Vv I L £, B e Lo e
3. Settings VA RUMIEL I RERDE

o

]

Totsl Time : 320 ns FESwitchioTable  Current: 1 3 ™y

AWG5000 & AWGT7000 V) —X DAy RA—hk2—H 3 =27/l

29



HaRDME

RT—HRR)\—

AT —HAN—X 2 DOMEEERFFHET, o7V 7 L —h, Run A7 —b, BIfEE =R Ofas DA
TR A FK R L ET, 51T, Force Trigger. Force Event. All Outputs On/Off, 33X Run AR & > D3 &
SNTWET, TNODORZLEI VI THE ENENDT 7o ar WEITINET,

30

Sampling Rate

YTV T L= IRFRIRENET,

Run Status

HEER O EN{EIREE (Running F721% Stopped) MNERINFET,

Run Mode

BAEDOEEE—RRERINET,

Force Trigger 8%

B 7%V @ Force Trigger 7R Z 2 LR UK HE T,

Force Event "R # >

Bl 7SR LD Force Event 7R Z > L [EICHEFE T,

All Outputs On/Off ;RZ

BITE 27XV @D All Outputs On/Off AR X E[RICHEHE T,

N ||| e

Run R& >

AT 7SR/ Run R & LRI CHERE T,
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RONV=VRFEDI—FHRE

System > Preferences... Z &R 45L&,
BATOT Ry I ANFRENET, @

1. Startup - FEIHE AR IFON &

5%&“%%@?}{'{0%&‘3"0 (48 /\0»_:‘/“ Startup Fit t Window Based On
r%?ﬁ&ﬂﬁ#@%ﬁ%yﬁgﬁ—éj Z% (%) Factory Default @ HAW Dutput Range

) ) Last Usad File @ O wavefom Data
) \E\\ °
Hald

_ ) User Default File
2. LCD Brightness — LCD D & 4 3% t

ELET, | | —“C
3. Fit to Window Based On — X — A+ @ LED Brighiness Remote Command Log
74/}‘5%4:@%@%2’?‘*‘/1/%%% SBJ [JLogtaFile
IR LFET, [ CovProgram Files\T ekionis\ &GS |
® H/W Output Range - TEE fiD [ oe [ comes | [ Heb ]
X#‘—/I/ﬁ§$%%%g:® mﬁﬁﬁgﬁﬁ 2481007
FHICEDIREDET,

B Waveform Data - ¥ E T — %%
bl EEHEI O A — LN RE
DET,

4, Hold - ¥ —/7 v A& —RLUA T,
AR EENERINTEE, R
DELLDINTA—REARFFT 50
EEELET,

® Sampling Rate
B Repetition Rate

5. Remote Command Log — A28 C
fEHEN% GPIB a~> ROy —/4r
VATFIERL TRLIENTEET,
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DAVRIDRRAZANEEET S

View A== —® Display Properties Z A7 107 « iR 7 A% {# L T, Waveform 71> K7 X Sequence 7+
VRUDERRFEERETEET,

Waveform 94> K™

1. View > Display Properties... Z2&R

Display Properties

THEAAT T Ry I ANRK IR @ : _
é hi‘j‘o e dow || Sequence Window
Waveform Window # 7 % 27Uy & @ ) Ceophee @ (ke
View / View
j—o (@) Analog ¥
2. Waveform VA4V RUDERT 4 — 8] Overlay @
~ LT (Graphic %7213 Table) @ e
PRI TEET, —cea
3. ZO WL Graphic £/~ T9, View AL @ @
X Analog IZEESNET, Overlay Units
& Grld O)j—:// jj%%*ﬂ?%i Viewdataas | Voltage © v| in [Points o ~  scale
B Chi ch2
4. Overlay Z®IRT 2L EHOT v o e
VIADT ST T — BN EeMerker Ederm
TEREINET,
5. RRWIEDT AL DRI ZHFINTE [ ok ][ cencel | [ Hew
\ij‘o

6. TEEfHOEA A TIRLET, View
data as "7 AT Voltage F721%
Normalized %8R L F£9,

7. Koo AL AR L £, Scale
R A C Points £721% Time %18
WRLET,
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8. Table 27V 79 %& Waveform 7 4
VR ETF—T A RRICEYRLE
—g—O

9. Table ZEIR L7~ X1, Analog />
Digital DWW nEFEELET,

10. Digital 28R 35 & Binary 7> Hex
RN TEET,

11. 7K S-dih & 72 (B il O BN 28 R
9, T —7 /L FIRT Digital 23R
SN TWAEA EE O BALFRE
(Voltage F771% Normalized) |3 %)
2720 ET,

12. Waveform V4> R DK F v x)L
TRREINDTAT LERIRTEE
T,

Sequence A K™

1. View > Display Properties... &%
FBL HAT RS Ry ) ABER
ET,

Sequence Window Z7 %77 L%
T,

2. F/R7A+—~<vb (Graphic F£7-1%
Table) Z IR TXFE T,

3. Graphic Z33&RL7-454 . Thumbnail
*7-1% Waveform Name DV 9 70>
FIBIRLET,

Display Properties

Waweform Window Sequence

() Graphic

View

Units

View data as

- Ch1 Chz
Ana]og Analog

Marker

harker

98 Table
~®
() Analog ;
©igial
(8) Binary
(O Hex

@

in |Points v | scale

] [ Concel ] [ Help

]

Dizplay Properties

Waveform Window | Sequence Window
(®) Graphic *© @ (O Table
Wiew
(®) Thumbnail (O Wavetorm Mame
[ ok ][ concel | [ Help
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Exk

B (AWGT7000 S U—ZD ) $HDHF v KD DAC BEEEN 10 By MIRESNDLE, ZDF v )L
D~v—HF —RIRREINFEE A,

B Waveform F721% Sequence 74> R CTA 27 V» 27 L Th Display Properties # A7 a2 « iRy 7 AILT 7+
ATEET,

Run State > rO—I)LEH DAY / F2

34

EREIEER — 2 TREFRAEDHBBIOE LZar ba— L3 5121%, L FTORAT Yy 72 EITLET,

G-

1. A 7%/ Run RZ 2L T
EERADORMBBIOME L2
r— L LUET,

BERAEDF / F70EZ%E

Run State (BhfEIRAE) =2 ha—L
LIEORET,

EENRIELTWAIREET LED A

Channel
All Qutputs CAUTION
TURN OFF DUTPUTS
BEFORE GHANGING
CABLES OR
POWERING DUT,

2. WAOaxr2nbEERIE 55T

VU= EITLET,
@
T A, B SR/ @ All Out-

puts On/Off /R %> F7- 1% Channel
Output On RZ L ZH LT, A5 H

NeFdANTDHUERDVET,

3. DOV, Settings‘ 21 ‘/]\‘"70)_Ch Settings
n (Channel) X—YZfEHL TE & Ch1 Ch2 | Timing | Run Mode | Trigger |
HMAEA N THZEbTEET,

Output Waveform

sweono
[ Interleave
0.500 %pp

\—ﬂ Zeroing AL
Waveform Rotation

‘_ Outpurt

Amplitude
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TrhulBXON~—bH IO NRTA=2REILHIH SRV DRZ L FT21E Settings 74> K7 @ Channel
/\o‘—:\/‘\wc‘??l/\ij—o

1.

R 7SRV D Level IRZ 2 & f#
LT, KT v RNV OREBRELOA
TRyb =B DA/ B
VARV EERETEXET,

[Fl4% 12, Settings V> K@ Chn
NR—=UEEHRALT, EiE. A7y
M, Z4NEEFRETCEET,

T—=ADNA, B — T AL A E
ETEET,

(AWG7000 >V —X) DAC 4 fREE
TI0EYhE®RIRTHE, ~—
INF 2 ET,

Direct Output DA /A7 ZEIRL
7,

(AWG5000 U —XR) £ F v )L
DT Fus NG B E AN
TEFET,

Y=y A —RUSDEE,
Output Waveform T Hi /J I 4 1%
RexET, T2 22090 T 5
& Waveform List ¥ A7 07 «Rv 7
ANFIRSNET,

VAT =R DL E,
Waveform Rotation T, 7122 H
J11E 5 DOALAH (Phase) £7= 13 B4
(Delay) #5% E CEXET,

Level

Amplitude Offset

(—

m“arkﬂr 1m

-w

high " g

()

b

ming | Run Mede | Trigger

T Marker 1 High

oo

Marker 2 High
I (ohT]

Marker 2 High

Ch1 Ch2 Timin% ‘n Mode | Trigger

Output ,::_/utpul Waveform
«» +5
An

' ATV

' waveform Rotation
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Marker 1 Low
oo0 Y

Marker 2 Low

Marker 1 Delay

HEROBE

DAC Res (bits)
o o1 e

Marker ? Dekay J Direct output

o Add ingut

M nirect Output

35



HaRDME

36

Exk

B BT RUFIENENSIL T OA Y /) AT HRETEET, HBOLTF v RO PF NTER
ESol, TIuns b~ =M O G BA NIV ET,

B Direct Output ZA NI T DL, TANHEF T B OFEIXENT /20 ET, TT-IEIE O E RPN EL
PVET,

B (AWG7000 >V —X) F7'2a 02 JLIET a4 BI04 72 ar 06 (A2 —U—7) O
HETIETANEEF T2 FOFREIELHYFET A, F7= Direct Output DFRELHVER A,

B (AWG5000 >V —R)Add Input I, Direct Output 2347 DL Z2{H F TEFE 9, Direct Output 23 IR
NTWAHE, Add Input [ ZE IR0 E T,

®  Waveform Rotation |%, & F ¥ R/IMNLL TR ETEET,
= Analog Phase = &£ (° | degree) THEELET,
= Analog Delay - Rl £/ 1R A M CTHRELET,
®  Waveform Rotation D% E %17 > T Waveform 74> R DO IE R R ITITHBLEE A,

DC HAR—D

1. 1£f§:?§ﬁz_€*yb—&bi 4 Od) DC C Ch 2 Timi Run Mode | Tri E DC O
Hjjj%ﬁ%ij_ Ch1 | Ch2 | iming | Run Mode | IIEI'J_sJ-?H vent | ”'"F'“t

) 0C 1

DC H /D v ~u 3l BN E% E T
ETET,

2. HAplkne (A / +7) obivEz
X9 _TO DC HAAF v i
@,
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Timing 3> bO0—)J)L
PV T L — R ray I DT A—HZ 1T, Settings VAL RO Timing ~<— THELET,

1. Sampling Rate Z5% ELF7,

2. ‘:/"_‘}7‘:/1-%~__Fu571~0) k% Rep— hz Timing | Run M::-(Ie/fngger Event DCD[MV_
(SClock Source

[ SR == S(Empling Rate CReference Source——| (CExternal Reference Type
etition Rate %‘fp} ET %i‘j‘c’ © internal ® Internal @ Variable (17120
3. 7uvy -V — A (Internal F7= 1% Repetitin Rate

SIVIEETHatE © External O Fixed  Reference
~ 10.000 000 MHZ ® Ext 1l
External) &R L %7,

B External ®EXIX, SMBA L —
ENHD 7y JE 5 HMEHS
7,

B [nternal OEXE, Vv /fE HiX
WELCAERESNET,

4, Jnaw ) — A External DL X,
Divider Rate Z§% & C&E £,

5. Y77l A+ —2A (Internal 713
External) #i®&RL F7°,
VD77 LA —AFoay 7 —
AN Internal DEZXDAHAEFNTT,

6. AV T 7L A H AT (Variable £
7213 Fixed) # RN L F7,
ZDONNTA=ZE, Iay e ) —A
73 Internal TUZ 7L A — X708
External DEXDHHFEH T,

(g
m BT —RE, Yay s — A Internal T, > ORDWT DR A2 T EEITHRIET
%\i—ﬁ_o

= U757l A/ — A7 Internal D L X
= U7y AV —Z) External T, A7 7L 2 A+ XA 7)) Fixed D&

B ERBEIEE R =X, Fixed AU 7 7L A —REL T, 10 MHz, 20 MHz, %£72i3 100 MHz D15
BEZTANET,

B JoyeY—A) Internal, Y7 7L A+ — AN External, A5V 7 7L A« Z A7 Variable D&%
Multiplier Rate ##% € T&E£ 7,
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FrorILEE

HEDOT v FNDNRFGA—RF e — AR CTEET, ZOMELT v 1A (Channel Coupling) &
FEONET,

1. Settings > Coupling... Z#IRL T, Settings Tools System Help
Coupling ¥ A7 « R 7 A% B &
Ec Analog High/Low
F771%. Settings V4> K7D Chan- Waveform Rotation k
TR Koy s BB LR CE e
+. Marker High/Low
Coupling...

2. Coupling D 7 {EAEIRLF9,
Chl1->Ch2and Ch3->Ch4 %
W+ HL . ChlECh2,.Ch3eé
Ch 4 DRIA—=ENENENFEE _ ®o
hEd, "ocm ¥ Ch2 and Chid-5 Ch4

3. Ch1->Ch2,Ch3, Ch4 Zi&IR+ N
AL Ch1 M5 A—%L Ch2. Ch @)Ch1->Ch2.Ch3.Ch4

3. Ch 4 DRTA=ZRFEGSIE [ ok [ cocel |[ Heb |

jﬂo = — —

Goupling

Exk

B Chl1->Ch2,Ch3 Ch4i3.Chl1&Ch2, Ch3, Chd BEESINDHIELEEEWRLET, T42bb,
Coupling 237> DIRFET, Ch 1 D/RFGA—FDENAEREDNN—R T = TR EIE A S ET, Settings
(>R Ch 2, Ch 3, Ch 4 ~2—T Coupling DXt R E/RDH /8T A— R TIKAFRITRY  BIRTX
7270 ET,

B FRONRTA=ZE, F v FAEE O RNLRIA S ET,
= FYLU LN AFa—
= AP
- V=T ARE
= HMERAE S ATt Re
= Waveform Rotation #%#E
- =T A
= HOWEFICEBRORNNATGA=F L2 X~ —ARRDA Y | F 7L

AWG5000 $ & AWGT7000 1) —X DAy RB—hkA—H -7 =a7I)L



HEROBE

FroR)-AExa1—RE
F X R AF2—L I FTF v RNV D AT 2— (BIE) 2+ 5T,

System > Channel Skew... ZE&R T2
AT AT Ry I ANRRIINE
7

1. #F ¥ RINVDAXF 2 —%5FNE (

GChannel Skew

ST LU TR CEET, ZORE
X, 7 e AR N~—F
D IS ET,

2. AXa—DEERETLE XAT

B Ry AD RN BRI \\\\__,///
_g_o -100 ps 1] 100 ps

[ Cose | [ Hoe |

oCh2: 0ps

e SHEHOBEEN 1 F Yo RN BT NLVOEE, Ty b Ax o — OERRIIFEH TEE A,

A3 —1)—7
AWG7000C >V —AXDF 7 ar 06 BB LN AWGT122B Bl A7 a0 06 BLICi%, A2 X —) — 7 HGE
PN TWET, 2 DDOF ¥ KL EA L Z—U—F LT, IVEnio 7L —h e EWERTEE 42 £H,

LT,
1. 4"/5’“‘9*7%%‘/&1?’5&16?\ ettings
Settings VA4 R D ‘Ch 1 =% Timing | Run Mode | Trigger
EINL | Interleave Ry 7 A% F = ' e
ILES (
° Esg )
2. /f‘/?“‘U“‘7%ﬁ“‘/K"9‘"§)E\ Ch2 Amplitude ﬂ fiis

N—=UMKEBIZ/Y, Ch2 D/XT T.000 vpp
A—FXBIRTE R ET, —

\—'_. Zeroing - -

Waveform Rotation
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3. AH—V—=TNAF L DIRFED L&
Zeroing DAY /| A7 &R TEXE

Ch1 Timing | Run Mode | Trigger
—éﬂ ° Outpurt Output Waveform
Zeroing &4 AT T BL , I8 v smetooo

RKLUET D, IRIEORREL VDA
PVET, T 74V TIL. Zeroing

F7TY,

Exk

Amplitude

Waveform Rotation

[ Interle

—
= Zeroing L

B AUA=)—T 37 el HCEHENET, A2V —T B AF L DEEIZIE,0,0,2,2,4,4,6,6 &
VOIS E SO~ — T — AN hEnET,

n HARA L DRETAZ =) =T DA ) FT7E2GFEZLE, T ATITRVET,

UTFORIZ, A Z =) =TI X THERSND Y T L= EBIE R OBBRAELEO LN TVET,

WELRBLIOA Ve

N A F—=)—7 B Ay T L—h ERE

AWGT122C A F 12 GS/s ~ 24 GS/s 2 ~ 129,600,000 7RA>

AWGT122B 7l ~

(FTvarol B 47 Fo 10 MS/s ~ 12 GS/s 1 ~ 64,800,000 A A2

Tar 06 ) K

AWGT7082C ! T 8 GS/s ~ 12 GS/s 2 ~ 129,600,000 7R A

(FFvar 01 B 4 h

gy 06 ) * 10 MS/s ~ 8 GS/s 1 ~ 64,800,000 A2
k

AWGT122C A T 12 GS/s ~ 24 GS/s 2 ~ 64,800,000 A1

AWGT122B %l ~

(FF>ar 06 ) * 10 MS/s ~ 12 GS/s 1 ~ 32,400,000 & A >
k

AWGT7082C ! T 8 GS/s ~ 16 GS/s 2 ~ 64,800,000 A1

(FFar 06 ) h

*7 10 MS/s ~ 8 GS/s 1 ~ 32,400,000 A >

k

AWGT122C Pi I, 2L 10 MS/s ~ 12 GS/s 1 ~ 64,800,000 A

AWGT122B 7l ~

(A 7ar 01 B

AWGT7082C ! L 10 MS/s ~ 8 GS/s 1 ~ 64,800,000 A A2

(A 7ar 01 )

k
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BELBIOAF S a

N AVE—=)—T Y SV T —h ERE

AWGT122C %1 2L 10 MS/s ~ 12 GS/s 1 ~ 32,400,000 A
AWGT122B # k

(FEHEE T V)

AWG7082C % L 10 MS/s ~ 8 GS/s 1 ~ 32,400,000 7~ A >
(FEHE T L) k

Ao58—)—THRE

AZ =Y =T, Frr g 1 EF v 2 OMNEEELT L FX RO 2 OV TV T L —h
EETDEEETT A F =) =T BA D& F o RV RO AR LIRIE DR X2 E 2 TxE T,

1. Ch 1 ® Amplitude 73 0.75Vp-p IZ

RESNTNDHELET,Ch 1 D
Amplitude X Settings V4> R T

ADLETS,

System > Interleave Adjustment...
% EER LT, Interleave Adjustment
AT R I A TR LET,
Relative Amplitude OFHEfEEL T,
724 %13 0.100 Vpp Z A JILET,

NESAIIZ Ch 1 Amplitude & Ch 2
Amplitude DENFHIES NV ET, &
BRIZTTHOES B,

Relative Phase I%. Ch 1 Z[E &L .
Ch 2 #2bS DI LICKVFRES
WET, HBEOHAILE C ) T
T RTEL VIR DEBYTT,

® -180.0 ~ +180.0°

AWG5000 3 & AWGT7000 S —X S Ay X B —

Sutput Waveform
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Adjustment Value : rsbj 00 Vpp

Ch 2 Adjusted Amplitude
*
0100 Ypp
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v
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Amplitude
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180 ° »
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| Close | Help |
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p g
B Amplitude TiX, NEBAIIC Ch 1 & Ch 2 O AT IS E T, NES Amplitude DfEIZR DX TEH
hEd,

= Internal Ch 1 Amplitude = Ch 1 Amplitude Value — Adjustment Value

l

= Internal Ch 2 Amplitude = Ch 1 Amplitude Value + Adjustment Value

¥ : Amplitude FH¥ETiX, Ch 1 ® Amplitude D% E Pl REFLFH T EEZ 7% € CTXE£ 7, Ch 1 Amplitude ®
HREICL>TE, FHBE e KME 213/ ME IS )/7ézh ZOEMNN—Ry =T I AENET,

TORIWHEA(F T3y 03 #)

AWG5002C iU AWG5012C T AWG5H002B B AWGH012B DO KSR Tl A7 ar 03 Bk Ty
BT —Z N FREICIRDET,

1. % S Chl F. Ch2 il N = . - 7
RN U EYRDT VAL T — =OF 3 T|'l ﬁ C |
&Hjjj)zﬁo) SMB j*?&b“ﬁﬁ%é | © . ® g 5 - &2 e 1
WTWET, e xR al 1

a®
S
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2. HIIL UL e RGRA—=RLLTIKRD
W EREELET,

B Digital Amplitude/Offset

B Digital High/Low

TUHNVH IO SV D LR
U-’C‘\—é—‘o

B 1.0V ~+2.7V, 50 Q #&¥fi

B fERE 0.01 V

Bk

Settings

Tools System Help
Ch 1 Level

Ch 2 Level

Timing

Run Mode

Trigger

Event

DC Output

Analog Amplitude/Offset
Analog High/Low

Waveform Rotation -

Marker Amplitude/Offset
Marker HighlLow

Digital Amplitude/Offset
Digital High/Low

()

Coupling...

HEROBE

®m Chl&Ch2oHFERNCa Mr— A TEET R, 7Ius heT O N, Rkt /4

TENET,
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AR EDRIFESCIE VL, WET — 2D AR —h, I AR =2 E D IR 7 7 A NV HIEIT File £
FEDOMEONH LA E D Windows DFEUER 72 8 /EL File A= 2 —

—a—EFEHLET, £, BEEHLE

TITNET

File A=a2—

THDOA=z— a< RN File Az —|CHEBEENTWET, FAZ2— a<w ROFEMICHOWTIL, &

VIA eV T BTN,

1. LHHEREEREEZMFOHLET,
@7 = [F7 3V NRE ) S ),

2. WRREAT—RTDDDHAT
R Ry I A KRR LET,

3. WS ELRF (LEFS) LE

‘é—o
4. HIRORTIZARIE ST TRIEL
i—é—‘o

5. WET — 4% A R—hLET,

6. WIHF —S&MDT TV r—ar
THAT 50T/ AR—FT&
ijﬁo

7. TV BALIERET 7 AI)VIND
ZIZERRENET,

8. 77V r—varafk TLET,

9. 7V —al kT, s
b LET,
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9 HEeE®

Edit \iew Settings Tools S
Factory Default Setup
Open File... Ctri+0
Save File Ctri+S
Save File As... F12

Import from File...
Export Waveform to File...

1 C:LAWG Sequence-4.awg
2 CLAWG Sequence-1.awg
3 CLAAWG2CH100SEQ.awg
4 C:L.AWGWer2iSetup4CH.awg

Exit

Shutdown
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(g
B T U —a A REBUREE T, B SR DT — R &2 (On/Standby AAvF) ZH4 41T

IO R ET vy MR TEET RNY— R E T L BUEOREZRAFT D E DD
BB T DX AT 0T IRy VANK RSN, DY vy MU - T a v ARG SET,

HBREZREITS

AR ORELRAFT DI, TROFIHEZFITLET,

1. File >iji\:erfile ’i:i%?ﬁ'@"%’)ﬁ 25 BEAfr File FEdit View Settings Tools
?j%?fg?b%ﬁé NIERET 7 FactoryDefault Setup  Ctri+N
] 7 @ Open File... Ctri+0
2. BUEOBREZHLVBRET 71V L — -
L CTHRAF7 BIZX. File > Save File }
As... ZRIRT B, £ IXATE S @ Save FRCIial i
FRIVD Save N AU EHLET,
3. REERGFTOHATZIRINLET, Faes
4, T7ANEEANTTTHN, T 74/ Savein | ) AWG_Fies Mew v @ @
oL ETIEZFERHLET, 4
5. Save 7V /L FET, @;lhz:c’ent
[iocuments
De-sktop
¥/
My Documents
by é;futer @ @
‘;—11 File name: Setupl.awg V., Save
MyNevork | Sovessups: | avaava) ]
EVk

B REERFTDHEXC, W T +—~ v D Integer DGEIE, RIET 7 ANV DI AZXP/NSLIRDET,
BIEDT —H4 7 3 —=<vh (Real 7213 Integer) IZDOWTOFEEMIT, A TA  ~ILTESRLTLE
éb\o

B Waveform, Waveform List. Settings D& T4 R T, WIEDO T +—~ v b eE#d 5L& 1%, Waveform
Properties Z A 707 « iRy 7 AZHHLET, (63 X— NKBEOT a7 4 %2RT5] =),
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BBRREETUHT

File A== —%721% Windows Explorer 2O g i E & MOV 2N TEET,

1. File > Open File... IRINT 5 &2{% File Edit View Seftings Tools
Open File A7 07 <Ry 7 AN

RENE _g_o Factory Default Setup Ctri+N

( ) Openi File... Ctri+0

Save File Ctrl+S

Save File As... F12

2. RET7ANERIRLET,

3. Open 27Uy /L7, Look in: | £ AW ¥ O -
N .i.,:‘jAWG_FiIes
u“’j Sequence-l.awg

My Recent __Secluence.a\:vg
Documents 5 i

= "SetupﬁBit.awg
@
Desklop

@

@ Setup_File. awg

&

My Documents

9

y Computer @
"_11 File name: Setupl.awg bl Open
iy Metwark Files of type: | awg [“.awg) |

ek
B TEFEEERL —FTHRIEETDN AWG OT77ANERET 74 ELTHEALET, Open File # A
Tag iRy IJATIL, T 74V T AWG DT 7 AV DBNERENET,

B W ARERFFOH &, IO ENT-3% 1% Save File %721 Save File As... WEITSNDETHRE
SNFET, RO T A KB EH | Save File IR T DL RET 7 AT HIC EEEENET,

B ORET T ANVPIEOM S DL, DC Output Z & T JAT —Z ATA 72 ET,

H: AWG5000 2V —XEBLAWGT000 >V —RATIERMLIZER T 7 7 AT HEIBMENHOET N, R T
T AN DA RT A= F N YR O R — M EZ B2 CTO DA I ESE A —URNERENF
T, ZOGE . AN D RTGA=HIT TV MELIRDET,
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Hii [ 2 XL D Factory Default 7~ % > % -9~ & T35 H fir b

1. WEROREE T N IRFIREEC
B 9IZiE, B 7S/ @D Factory
Default RZ L ZHL F7,

2. RENEHEINTWDELEA . BIE
DR ELARAET DNEID TR
HEATOT TRy 7 ANE I REIVE
‘jﬁo

3. File A== —3b% T TR &
EREONHETZENTEET,

Open

Save

Factory Default

-

AWG?122'o

\___'.:J o'Do you want to save current setup?

-

File

Edit View Settings

' Factory Default Setup

©

Open File...

Tools
Ctri+N
Ctri+0

Save File

Save File As...
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Ctri+s
F12
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ax ;&

BERIEOH T 2L TEET,

DRFEFHL
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BIRBRARFIZFFO SN DGR E 2RI TEET,

System > Preferences... ZIZIR L T,

Preferences # A7 07 « iRy 7 A TR Freferences

LET, LT FNSLEIREEARFOHK Startup

o g am N

EEBRCTERT o (%) Factany Default

1. Factory Default — FEJFR&EARIZ, T .
S5 M I R AP O S U ot

2. Last Used File - EJF & AREIZ, £ o () User Default File @
TR ETIIERNHE N3 E e
MIEO S ET, =

3. User Default File - FEJR#x ARIZ,
=P NIEELERET 7 AN
IO HE N ET,

4, TFNE T AL Z I ) 7T HEER

ETT7ANEIRET DIODE AT
aJ ARy 7 ANFREINET,

ZDOT Az tE, User Default File 73
BIRSNTZEXITHIRDET,
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BET—20DAHR—F

T AR — MBI o OB DS TR S VI 7 — F N T B e T, 75 A
R NUTHLOB AR LY, BE(F DU 7 — 5 2 B E A DI L CEET

EEEEERL —2E ROT7ANVERE YR —FL£T,

AWG5000 2 —2FB LT AWGT000 U — X THERL LT- . AWG 771 /L

Tektronix AWG400, AWG500, AWG600, AWGT700 'V — X% CTIER LIk D7 7 A VI
= % PAT

= *SEQ

= % WFM

Tektronix AFG3000 U —RXDALE /77y ar - BxrL—2 TEMRLEZ . TFW 7 7 A /L
Tektronix DTG5000 ¥V —AD T —H XA T« B R — X TIEK LTz *.DTG 77 AL
Tektronix TDS/DPO 3V —AXDF v uAa—F TERLIZEIE 7 74 /V (. WEM, *.ISF)
TXAN T 7 AL (. TXT)

TrAN AR — R DEEMIT. T TAL -~V TEHRLTIIEEN,

1. File > Import from File... Z®K 4 File FEdit View Settings Tools
A& Import from File #1471 7«

Ry 2N F RS ET Factnnr Default Setup Ctri+N

Open File... Ctri+0

Save File Ctri+S

Save File As... @ F12

Import from File...
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R S
2 RERINLE T, Import from File

3. OK 227V 7 LEd, A7y 7 4 \Z O AWGE000/7000 (“AWG)
iﬁ*ﬂ:ﬁf;\ File Import XATas . () AWG400/500/600/700 (* PAT)
Ry I ANRERENET, (O AWGA00/500/600/700 (*SEQ)

() AWGA400/500/600/700 (“WFM)
() AFG3000 (“ TFW)
() DTG5000 (*DTG)

() TDS3000, DPO4000 (*ISF)
TDS5000, TDSE000,

o7 PO7000,
Th B0 DSAS200,
_POJDSAT0000 (*WFM)

I OK s>:// Cancel I [ Help l
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4. AR —=bFT 277 ANVEIEIRLE

T,
5. Operation TA RN —MEEZ R E
LET,

B Setto- Fy¥r R Ar Ty
AZFERELET, HEL:
FLENCA R — T BN E
nYTHNET,

® Insert before - AR —hT B
TR EL 72 B/LORTIIZHE A
SNET, BfEE—FNT—7
PAUSNDIG G ZODRT A=
XIS ET,

B Create only - />R —hMT 5
JE 75 Waveform List 74> K712
RREINET,

B Overwrite - BEfF DB IE T — %
N EEEEINET,

6. Change H/W Setup ZfEHL T, 1
VIR—NT BT —ZIZH T
YT L= NOIRIE, AT 2y hOfR
WMNEENDGA . EOFHRETY
IADINEIMEIRETEET,
7=& 21X, Sampling Rate #F =7
THE, AR —ITDHT —HERL
BEDFIHINAIIC, TV
Tl — IR EUNCER ESNET,

7. Open 27V 7L %E,

AVR=NF DR OT 4 —~> b
N, % AWG, *.DTG, *.TXT OFE
I, ENEUCKHE T 25 AT s -
RO ANEFERSINET,
AR — T HERDOT +—~
% AWG, *. DTG, *. TXT LIFtD
BaE BRI 7 7 AN DA TR —
rEH, W4 HY Waveform List U
YRV ARESIET,

File Import E§g|

Deskiop

REDRFEMHL

Look ir: |L)AWG vl O M-
5 ) AWG_Files
_-.9 h"i\l'e(Z
MyRecent  [[D)Wavefarms
Documents | || ] 2CH100SEQ. awg
u | 4] Sequence-2. awg

| 2] Sequence-3.awg
£] Sequence-4,awg

O,

g] Setup3.awg
Lﬂ SetupS.awg
My Documents
My Computer @
! Filerame: |Sequmoe1 .awg/—ﬁ\ v [m
liyNetwark | Filesof ype: | AWG [~.awg) Dt " v Cancel
69:-4.0" Change HAW Setup
(*) Set to Index Mo |1 v | at Eh|1 v "] Sampling Rate """J
O Inset before ] Amplitude/Offset
O Create only
O Ovenwiite

AWG5000 & AWGT7000 V) —X DAy RA—hk 2 —H 3 =a27JL

51



19—

ax ;&

52

DRFEFHL
8. AR —FTDBT77 AN Tek-

10.

11.

tronix AWG5000 U — X F7- 1%
AWGT7000 2V —XDFA ., FHDO X
VIRBEAT T AR IANE RSN
£,

AR =T DR RINLET,

. OK &2V 7§58 WKT —47

AR —hSET,
—EICEHBOWIET — S a2 A
RN—=hHIENTEET,

A2 R—1F 577 AL Tektronix
DTG5000 SV — X4 HDID
REAT AT <INy I AINRIRSIVE
7

AR —F4% DTG5000 2V —R7
Ty F—ZD4E vk (DTG bits)
AR OE YR (AWG bits) (2]
0YTET,

AWG5000 $ & AWGT7000 1) —X DAy RB—hkA—H -7 =a7I)L

AWG File Import

Waveform Mame Length Date

2 Il | >

D;rG File Import

DTG hits AWG bhits

L 0K J [ LCancel ] [ Help ]




12. AV R—=FFT BT 7ANINTF AR
TrANDEGE  HDXOIRE AT r
TR I ANFKIRENFE T, Format
T, 77 ANVERERINLET,
DAC OEE YRR ELILWEEIZ
Digital Z32IRLF£9, AWGH000
Y — XTI, Digital 1% 14 B> MZ[H

ESNTHET,
13.Normalize T, /—~J A XD 5k
FIBIRLET,
B None - /—<T7A4RX&EITWER
/\/O

® Fit to DAC range, preserve off-
set — 0 ZHUHELL TR —Y
TINET,

B Fit to full DAC range - 7T 7 —
2O He/MEDS -1.0, F KED
+1.0 1272230 A=V &
nFEI,

14. A AR —RFEATREIZ, R U4 FRO I
R TIZHEEL TWDGA. A D
Yo AT aT ARy I ANRFR RS
NWET, WA EIMRZ D551,
Yes 7213 Yes to All Z#3EIRL F
7,

ek

Text File Import

Farrnat
(=) &nalog
() Digital 8 bits
() Diigital 10 bits

Wormalize

(%) None

() Fit to DACrange, preserve offset
) Fit ta full DAL range

=1 —]

ax ;&

3

| oK

J { J |

Cancel Help

Gonfirm Waveform Replace

Current Setup already containg a Waveform named 'Sample-1".

“whould wou like to replace the existing wavetarm

Wwaveform Length 960 Points
modified:  Saturday, Jun 24, 2008, 4:25:44 Phd

with this are 7

Waveform Length 960 Points
modified:  Saturday, Jun 24, 2006, 4:25:45 PM

DRFEFHL

ll [R0s]

J |

Help

B LUV EIERTAEXIE. AR —R L7 7 ANV DL BT THAER DL R0 ET,
B Tr A AR —MMEREE FITT DL, MEFEOREOTFAXIIA R = ENT=7 7AWV ERICER R

EHEINET,

AWG5000 & AWGT7000 V) —X DAy RA—hk2—H 3 =a7JL
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DERFEFHL

BET—3DTHAR—k

EEREEYRL =X, WIBET — 4% «TXT BROT7 7AWV EH|L T VAR —bTEET, F72.
AWG400/500/600/700 SV — X T TXB/Z —L « T A NLRLW T 7 AN EBINT AL TEET,

54

1.

T AR—NT DA TRINLET,
Waveform List 74> N7 T 415
RLFET,

FIV I L TRy T Ty e A= a—
Z#F R LFE T, Export Waveform to
File... Z®INLTHX AT T KRy
A RRLET,

Sequence ¥£721% Waveform V4R
7 CH IV 1L T, Export Wave—
form to File... Z3#®IRTEET,

AWGT000 2V — X T Real FEH.D
WHE T AR = HLEDH AT
as iRy 7 ADH T,

TrANEREBEIRLET,

Real v X o H E %
AWG400/500/600/700 <Y — X T
i T&% *«WFM 77 A /L2
AR—FTEFET,

AWG5000 $ & AWGT7000 1) —X DAy RB—hkA—H -7 =a7I)L

Waveform List =

“ Export Waveform to File...

Standard Waveform...
Delete

Delete All Waveforms
Copy

Paste

Rename...

Go To...

Waveform Properties...

Format

Texd(*TXT)

(O Text- Digital 8 bits(* TXT)

(O Text- Digital 10 bits(* TXT)
AWG400/500/600/700 Waveform(*WFM) &

Lo

| Qancei ] | Help |




BEDREEIFHL

6. AWGT000 >V — AT Integer JE= ; l
DW=/ AF— R BEEDH Export Waveform to File B|
/(TE’?'H“\“/&XO)@J“Cﬁ‘O WavefurmN Sine-3

7. *TXT BRAERIRL7Z54 . Analog ‘Waveform Data Type: * Integer
R Digital %%?ﬂbi#o DAC 0)% Format
vy bR E L7V B & Digital % (@ Text- Analog 8 bits(* TXT)

BIRLET @ () Text- Analog 10 bits(* TXT)

8. Integer & I O ¥ ¥ % | O Text-Digital 8 bits(“TXT)

AWG400/500/600/700 2V —XT () Text- Digital 10 bits(* TXT)

E_i:ﬁ f?g);;AT 774/14:3:7% () AWGA00 Pattern 16 hits(*PAT) & =

() AWGE00/600/700 Pattern 10 bits(* PAT) &

9. OK #27Vv/LEd, A7 101
TRF LRI AT BT R I AINF e Ok ] [ concel ][ Hep ]
RINET,
10. BT =2 77 AVERIET DS - 21X
Fa IR LT, am iSE
11. Waveform List 74> R TiEERL7Z - B Tenge 100t
W D4 RIS RS E T @Eﬁﬁ
12.Save =27 Uy 7 LE7, BN 72 €]
BT — 4 EARE LR D7 74 v e
LTI AR —TEET, :
iy Documeants
58
My Computer
¢ @ (2)
wp'lacesr File name: ‘m s C Save I
Save as hpe: :Tsxl - Analog 8 bits(* TXT) ~
EVk

B T7Fns T =23 )=~ TAALIEEL T2 AR — S LE T,

B nteger JERDIWET —F %2 =7 AR —hT5EX1T DAC S REREZ BRI TEEJ, EINL7= DAC 4
BEM Integer 7 — X% ) —~<T AR T —HDOEWIZHEHINET,

B T+ —~vb (Real £721% Integer) # 8 H 43121, Waveform Properties Z A7 27 « iR 7 AZ%Af
HALET, 63 =2 O T T2l T 5] ),
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B DRRERE

Waveform 74K

Waveform V(> R %4 FH U CHHICERR S 72 JE<° Waveform List 742 RUIZY ARSI TWDH 22—
EFRBEIEOmMEEITVET, Sequence VA4 R CTBBIRE LIz =L A MET I Settings V4> F7® Chn
N =V TERSNIZ WD Waveform V4 RUICR RS NET,
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1. Waveform WA R DT T T7HKRD @
#lT9, Chl & Ch2 7 F s -
?~5’&?*—7]-§4‘*—5i)33§ﬁ<éﬂ Waveform A
TV \ij—o (TD: D25V @: 0398V Point: 315 Pts. Voltage: 0158V [ Jn
2. ZOTAaAEIVITHETTT
FRRET =T NVRKRBEIE DY E
‘é—o
3. ZOT7 A=z (Vertical Best Fit) #7
Vo3 5L, T _XTOZLALRA
Waveform 74> FUNICEBIEL L
NTFag F X RO ESE
HELTERRLET, n
Paoints L] 200 400 EO0 an0 1.00 k 120k 140k 160k 180k
4- %_711/5,%%@{5”“6'?—0 Waveform »
FFABFRCH, TFOINT - ' —

. 7N N . o5 s - \& @ [~ :'% _,:,
UHAEBRTEET, ZoBES se=—=a
/]’ﬂ—UﬁZK@?«‘:‘/gﬂ/iéﬁ—{—(ﬁ—o -E‘_IE_ Do'l' nlt 1)15 1)14 Df nlz 1)11 1)10 Mll nlz no‘i n16 E

1 9o 0o o ¢ © ©o 0 1 1 0o 1
41t 0o 0o o o ©o ©o 1 1 1 1 o
1 ¢ 0o o ¢ © ©o 1 1 1 1 o
1 ___1___0___0___0___0___0___1___0___1___0___1_ _0__
(505 T i R Sk et Rt Rt T
B 10 o o o 1 o o0 1 0 1 o0
9 1 90 0©o o ¢ 1 ©o ©0© 1 0 1 o
__ 1 (1] 0 (1] ] 1 0 1 ] 1 1 0
2 “ 1 1] 0 [} 0 1 1 0 0 1 1 0

i o0 0 0 0 11 1 0 1 1 o
1 90 o o 1 o ©o 0 o 1 1 o
L 1 0o 8o 0o 1 0 ©o © 0 0 1 o
PEESs 1 0 0 0 1 0 0 1 0 0 1 o0
| 14 =N o (1] (1] 1 o 1 0 ] (1] 1 o

EVER

B Tl T —EOHh w—H T —EDIH, FIT I us b — O )5 &R T Waveform 7 42

Folc R TEET,
B Waveform VA RUDW KT —2%2 207 (WIH{) $2121%, Edit > Clear ZfEHIL £,
B TR ELHW & K Sl o BT (%, Display Properties # A7 02 « iRy 7 A AL CTHRELET, (32 X—
(T4 RUDRRAZANEELT T L) M),
B Waveform List V4> RU DA Waveform V4 R7IZ By M A120%, WEAZERL UEEDOF v

FIVIRTG T TR Fay 7 LET,

AWG5000 $ & AWGT7000 1) —X DAy RB—kA—H -7 =a7I)L



A—LZHERATS

—RFNCEEOFEME RI2WN GG A— DR E L £, W R REIER T 21213, View A==2—0

A —ha<w REERLET,

1.

Zoom In - Zoom In X7k J7 [ &
EE T AN R R IR R L E
T,

Horizontal Zoom In - Horizontal
Zoom In [Z/K 5 AN T & HE K
LET,

Vertical Zoom In — Vertical Zoom In
IXIEE S I EEIERLET,

R — L IRg O HE B il D A — )V IE
FH T DUV TIX, Preferences # A
Tay IRy JATHRE TCEET,
Bl R—=Y TRIY = FKIRDL—
PREE ] ),

Zoom Out - Zoom Out IXH[D A —
MMERICELET, Zoom Out 1L
JFEEIL KL TORMEHTEE
T,

Fit to Window - Fit to Window 3.
BIEET AR - AXZE DR,
A DA — L A L BEAEORTOR HE
WZR L%, Fit to Window 1% 1
FYERUTZB TOREHTEET,

A= LR R E B HRICHRET 21213
Waveform 7 4> N7 _E® Zoom 7 A
avEFEHLET,

Zoom 7 AL DWT N EERINL
T. W LTI L. K oL
TR—=LDORIG LRIy DR
AR LET, HDOWIE, D
RALNTHIZZYZLUET,

@ [Horizontal Zoom In

FEAIELL T 0@ T,

View Settings Tools System
Go To...

@ Zoom In

Horizontal Zoom In

@ Vertical Zoom In
Zoom Out
@ Fit to Window

®

e o
Oy TR

AWG5000 & AWGT7000 V) —X DAy RA—hk2—H 3 =27/l
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B DR EMmE

BT DR RS

Bdit A== —Z2f L T, LA ERLZY, BEF OB ERE TEET,
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Undo IZEBIOBHBIEEZ v &L

u 2 { Edit View Settings Tools System
;%Redo IXERTOBEAEZ D IKL ot o~
Undo 1%, —Y AL, K2, 35 ' “
J:(FX?D*—/I/%%JEE “!ii@ﬂﬂ éﬁ“bi Create Analog Waveform...

H A, Create Digital Pattern...

® Create Analog Waveform 7703 i
Create Digital Pattern Tix, A7 i X
a7 Ry AN NTERIER T Y Copy Ctri+C
B RE— TR TTCEE T, Clri+V

B Equation Editor Ti%, #HXxF4# -

DB W CTHEMER T2 AE KT 57 1ste-Replace
OO EVERTEET, Insert Waveform...
_ . Set Waveform...
= AR AE CH DI IE DY) "
DELY, = — BT B BR )M B
HT&EET,
V= AERIT YT R =
TlX. Cut. Copy. Delete IZT7 7=
Ve Zﬁ&‘/&fcﬁ@iﬁ‘o Sequence Control Parameters...

B Delete All Waveforms 1%, iRE 77 T O
ANVHND T RCO2—WEFZK AT
ZHIBRLET, t Subs

® Clear |%. Sequence V(> R Tk 'S :

RENTZ L A NONEEHIBRL _ _
FT, OO L ANIBEILEH 4
o
Waveform V4> R Tlid, B®IRL7- Si
F X RN DW T — 5% Clear L 5
£,
Waveform Properties...

AWG5000 $ & AWGT7000 1) —X DAy RB—hkA—H -7 =a7I)L
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RER T D ER

B DR EMmE

Create Analog Waveform # A7 07 « R 7 A% HL THLWIEEZER T E 9,

1. Edit > Create Analog Waveform %
IR T, Create Analog Waveform
FAT T Ry A EET,

2. Function T EOX A7 ZRINLE
T, VAW, A, FIRE., T
YT TR AR FIE
DC PO ERINTEET,

3. Timing TIE, A%, KEE. B
FOVAINDEIRTA—FEHE
TEFET,

4. Sampling Rate € Auto., No Change
DNT NN EEELET,

B Auto - 1§ 5B HIZIH U T
PRI EEy TV T L —
FNE B ESNET,

B No Change - V> 7Y 7L —
MIZLLEE A, B, 1%
B . YA7LD35D 2 5D
INTGA—BEHRETHE, FEVD
IS BEEMICEHESNET,

5. Preview I[CIETENFTRSINET,

@

@ © @@

Edit View Settings

Tools System

Create Analog Waveform...
Create Digital Pattern...

Equation Editor...

2481-004

Function

Timing

120.000 DO MHz

Frequency v |

Cycles v | 10
‘Waveform Length 100 Points
Sampling Rate

O Auto
Mew Sampling Rate : 1.200000 0 G5/

(%) No Change
Current Sampling Rate : 1.200 000 0 G5/s

Preview
oswv_IIIIIIIIII
ooNU_IIIIIIIIII
-0.500 V -

Points 0 50 100

AWG5000 & AWGT7000 V) —X DAy RA—hk2—H 3 =27/l 59
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6. Level T, {RM& / &7y Ei2lX Level
;j;_/ A= DATA—FERETE @ ) Ampliude / Offset
_ - High / L
7. Option T, #RiE / 47 hORE Otiigh/ Low
JiEZ B £, Option 71— A i 7.000 000 Vpp
IX. TEE O HEALIZ Voltage & 158
W7tz DAHFRRINET, Offset: \ 0.000 DOD v
FEE fih o BT 1Z Normalized Value @ Option
Z3R 3 5L Option 71— AL IE
s @%jﬂo (B2 ~—v Ty (®) Use specified amplitude and offset to calculate data,
RODERAZANEEETLH] &
ﬁ'\g\)o
Create data with DAC full scal lue. Specified
8. Operation T, D IERK T LR Oall':;ilf;d: aanﬁloffset anlaJ d?rzact'lapvaap:ll?ed ?: ﬂ;l’ew setup.
MEZRELET,
B Setto- Ty RILEA TV -
AF S EIREL T HHUW T pEEEn
EAERLE, $RE LI T st ) :
IR LI BB 7 A S % O ey SIS S
T, © Insert before Target ‘Waveform Mame
"] rt bef Ve 2 3 A8 () Create only
nse efore - W27
Sequence VA R DFEE LT O Dverwite
A DORNRASHES, @fE _
T RR— L AL DS Walvefolm Marne:
ZDT A TR E Uniited20 i
TO
= Create Only — HIHLIC I % 1f: o Execute | | Close || Heb
LET A W ITr—FEh @
FH A, Waveform Name HIZI%

D& #E ANTTLET, 1ERS
AW 1L Waveform List 71
VRO —WFEREZIAN
FRENET,

B Overwrite - BEFOKET —#
NEEXINET, ZOav»
REBRIRT DL, BlFEE—FEN
TWAIIE D Target Waveform
Name R 7 RZHEKRENET,
BIEAHEANNTDHRY A
(Waveform Name) IZ#EZhIZ720
iﬁ‘o

9. Execute #7Vvy 7§ 5& WIENE
REnET,

60 AWG5000 $ & AWGT7000 1) —X DAy RB—hkA—H -7 =a7I)L



(g
B Create Digital Pattern Z#fF FHL T, 7l K EDIER ERIU HIETT OX N Y — 0 BERR TEE

ﬁ—o

#BXTT04

PR T A2 ITH AN AN T2 925 ASCH TR DT H AR =5 4 X2 T, KT 7 ANV DF AT, TR
BLOar A X0 EERLET, 20T o X3 H I HE & 2k ME I 7L, Create Analog Waveform
Y — L X2 Create Digital Patern > — /L 721} CII R A GEZR, KOBEMERR I AER T 52N CTEFET, =T 44

121X Bdit A== b7 78 ALET,

AR s o 2o Hiz 0T 5l
MEIBEEHARTATT,

Z 7N BOND RO R I E R 2y — LB E STV ET,

AWG5000 S & AWGT7000 V) —X DAy RA—hk2—H 3 =aF7/L

1 ODOFF AR AN T DR
FHIT, AX— 2% E T 256 L
T,

1 >OTal S AOEKRE (£AR
VT EOAE) L 1,000 LFETY,

7 B> h® ASCI XXFE v D I ffi
ATEET,

AN 7 OEFE I ITan 2 E L
F9, AN T ICEEEZ DA T
5] . ”AA”:i:"Value”

BAL, R1FE. UIVELD, =" — B
722 EDEREIL, Y — L R —D
TAa w7 LU TITWET,

Equation Editor

@ H LR
Untitled. equ
Text Editor

B DRREmE

Olutput

Selection

@00 ooovems
G oPovovvvvoeoeoew
——— —

Input/Output file path : C:h. ASpstem

Waveform Functions

Math Functions

[Cumpile] [ Cloge ] [ Help ]

2481-009

Soft Keypad # 7 & T 2L, B LOF—HR—FTTF =AU FELEEATITEET,
Basic Keywords # 7 2 ] 95 & & H DEECHIAT — A MR RIANTEET,
Waveform Functions #7234 2&, IAEM T2 WA EE RN TEET,

Math Functions # 7 i 195 & | A BB EZ R BENO —HEL THERACANTEET,
BT 4 2 RW BB OFEMIC OV T, A TA L -~ LT ES L TLEED,
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REI7IMIVADERESRT S

VERR S U= 1L, Waveform List V4 ROl — P BRI &L TR EESILET, Waveform List 742 R IZ
I, By T o7 T 7 AL (kawg) IRAFSNICIKE DY ARSI TV ET,

1. EXFABEEERRNTDITE.
Predefined # 7% 27V 7 L %4,

‘Waveform List

2. EFFHBIHOLHIOEMIITT Predefined
RHYRG A A () BOXET,

H: EREFAEERE. HIBR, 4
BESTLHZLIITEER A,

3. 22—V EREIBEEIRT DT,
Waveform List C User Defined #7

n Lisk

%7U‘)7bi‘a—o UserDe;iri‘ed
BN 72 % Waveform 7 A2 K Waveform Name | Length | Date

IR TG T T AL, 22— E

BB ERETHIENTEET,
4, WEOLFR, WK E., £72X B £

Bz Y AR ey —hTEET,

5. Waveform List V4> R TlL. I&E
FIIT 3 HrcERINET,

£ il | »

6. IERERBIEREZMOIVEZIT,
WREZBBIRLTEHZU Y7L, Ry

Waveform Properties

707 > 70 . )( - z)) rQ Waveform Wiavetorm Length :
Proper’ties... %@*Rb(i‘%%éh 1024 Foints
DEAT AT Ry J ATHER TEE
—3«0
Olnteger
[ oK J ’ Cancel ] ’ Help
EVk

B Waveform List V4V RUTHE I I $TEE Ry T T T A a—NERINET, WEOHIKR, o —
RONR— AR E DA 2 — [ TT VB ATEET,

PR AR T B LI, ERE BTG LR LA ME D BT LI TR A, TR T
LIEBID A Hil S TS,
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B DRREmE

A—YEBERBOEBHEEET S
Waveform List V4> RIZE/RSNDL—F ERBE I OLAIZEE TEET,
1. Waveform List V4> R T % @ e &l

BEIRL, A=z — - X — TEdit >
Rename... Zi#4R9"5& Rename 5 @ Change Waveform Mame
ATRs Koy A m R ALET, e
e name: Sample
2. BIEOWIAMDBRRIIET, @ | To o |NEEEE | EEEE

3. LWz AILES,

BEOTONT1EHRETS

Waveform Properties 4 A7 07 iRy 7 A% AL T, KT —FDO7 a7 42BN, BHTHIENTE

\i—aqo
1. Waveform List V4> R DY A WaveformList
MPBIEIEZ IR Ry T 77 User Defined | Predefined

A==—7)»5 Waveform Properties...
BBINTDHEXAT O Ry 7 AN v
?»% i_\. é ﬂi‘g—o = Standard Waveform...

Delete
Waveform 74> R Settings V4
VYO Ch ~—=VTA Yy 71T —_—

Waveform Name Length|Date

% Waveform Properties #7127 Copy
Ry I RT 7B ATEET, Paste

Rename

Go To..

Wavweform Properties...

2. WEELAHR / EETXET,
3. WIETF —2D74+—~vh(Real £ :

Waveform Properties

=% Integer) e EHTXxE < ' aveform Length
9, [ J 048 Faints

@=—~:@ |' Data Type

(*) Real ) Integer

[ 0k ] [ Cancel ] [ Help
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BT Dk

Standard Waveform Z A7 07 « ;R 7 2% H L TIEMR LR .. A2 R —KL72K B . Waveform List 7>

64

Foiz

VAREIN TV D2 —VERF B ERETEIET,

FATLELYS
B atmtEd LT MBEOI =Ty LTHE T AT LEL VUV EIRELET,

1. WIAERETIZOHIC, ZRHD R
—a—RHEBEINTWET,

2. WMEDT AT LELTROWT L)

ZIERLET,

(1): 0499V @: Paint: Voltage: i -
CiPos: | TIPS Capos: | TP ®, @ G S o

Export Waveform te File...
Standard Waveform...
Cut...

Delete...

Copy...

Paste-Insert

Paste-Replace @

Clear A —
Scale...
Offset...

Invert...
Shift'Rotate...

Chn7J)wmr-5—%

Chn~—h15—%/~—N
2T —X

All - T RTOTAT LD mtE
DOFHREIRDET, All [T Cut X°
Copy THEHENET,

All Analog - ¥ _XTHOT7F s -
T AR DOX G LT ET,
Scale X° Offset M A== — Tk
WTEET,

All Markers — & _XCDO~—7 -
T A DREDRI R LIV ET,

3. WMEDOLUIELTROWTNNE z @
RN ET, ut

All - BIRLTE=T AT DAL L]
URmREDO KRG LI ET, OAl

Between Cursors = 2 2D —Y (@) Selected
NEIDFRE O G0 ET,

Selected — JEIR L7~ &0 JH 23 e £E
DRGLRVET, F—T N F rOoa
ROEEDIAETT, @

Range

) () Between Cursors

(@) Selected

I OK ][ Cancel ][ Help ]

T W2y 7R —=Rid, AR OT 7V r—aWNIhHY ., Windows D7V FR—REZHIOE DT
9, Microsoft Excel ZZNBAMES D7)y TR —RIZT —HEMRIETHILILITEEEA, OT 7V r—g
UNHDT —HEE TR AR = ) AR —MEREEEALET,
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Cut XU Paste £ 4EHI

B DR EMmE

U TFOFINETIX, Waveform V4> Ry (FT7FKR) TOD Cut & Paste OEAERIZRLET, T—T VKR T

H Cut X° Paste #E{TTEET,

1. WMELIZWTATLEBRIRLET,
ZOFITIE 2 SOF v R A
AL TEED T IO — AT
WET,

2. h—INEFEHALTLUEREEL
ij—o

3. Edit > Cut... ZE{RL T Cut ¥ A1
Turs Ry ARREET, DX
IR FT,

B [tems - Selected

B Range - Between Cursors
TAT ARV VEERLIZNEE
X, ZOFAT el Ry JATER
T&EET,

4, OK &7V 7 L%,

5. WIEO@INLIER 5 Ay hShvE
TO

E: —HOT AT AT NEFITHEI R
SN THREREIZELRVEY AL, T—
AT 7 RLET, TR EE O %
DX, T 7+ NV MER ANV ET,

H: T XTOTAT LDy NEZIX
HIfrEh b L, W RITZZ DS ELRD
F7,

@: 05V

AC: 286 Pis C1Pos: 'S

Point: 17 Pis Voltage: [T

0.600*

AU

Ch1mi0 i
Ch1Mz0 : |
c1|z|u1n : 1

1
|
1
200 400 600 800

Ch2 M20 | .
Points (i}
Item
Oal
(%) Selected

Range
O &l @

(+) Between Cursors

CoJ @) (e ]

C2 Pos: | 56 Pts

AWG5000 & AWGT7000 V) —X DAy RA—hk2—H 3 =27/l

czpon: [ THPRE & ® ® & o

@: 05V Point: Voltage: B

C1Pos: 70Pis

QR X QA
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6. Ch2 Z®INLET,
7. I—YNVEMHERL CREN R 2T

9.

ELET, Edit A==—>5 Copy %
BIRLET,

Paste-Replace @ T9°, Ch 2 @
HBELE#ENN—2A&N, Ch 1
DI EEH 2 HIVET, Ch 1
DWHEFTEILETA,

Paste-Insert M %] CTJ, Ch 2 D5
ELT-#PA Ch 1 OWIBITHA
ENFET, Chl OEFEENELEDY
*9,

AWG5000 $ & AWGT7000 1) —X DAy RB—hkA—H -7 =a7I)L

Waveform
@): 0490V @: 05V Point: Voltage Ea
AC: 286 Pis C1Pos: T70Pis (2 pos: ¥56 Pis B ®} e g ur

Points 0 200 400 600 800
Waveform
@: 05V

AC: 286 Pis

Ch1M10
Ch1M20
Ch2 M10
Ch2 M20 |

Points L] 200 400 600 800

Waveform
@: 05V

[AC: 286 Pis
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B DR EMmE

BE R

Math X A7 a7 iRy 7 2% AL T, fMEL TWAEFICH L THAEEZEITTEET, 2 20T el K
T—ZEME . WE . TR CTExET, B LKL Waveform List IZBINSLE T,

1. Tools > Math... ZE&IR§5&, Math Tools System Help
FAT T Ko s A E FENE -~
j—o
2. New Waveform 7 — /L NIZIR D Math @
LR E N LET, @ o o
NewWaveform: | Sine-1
3. WIRVAND L EZRINLET, _ _
TAar &Yy %HE, Waveform - [+ O +
List &471:1& ¢ 71—“/ 7 A b‘%%é @ Resolution for Calculation
ﬂiﬁ—o (®) 8 bits O 10 bits

4, WEFEBRLUES,
5. (AWGT7000 >U—X) s fifhe % 341

6. Show Preview & F =74 5L il e ‘ ‘ ‘ ‘ ‘
Bk a8 Preview (CERRSNET, ' ' ' ' ' ' '
7. OK #2020y 73 5L, FHLOEEN sl

Waveform List 74> RIZIBME N

i@‘* Waveform Length : 10 000 Points
o

@) ) @

Preview

(g
B OB RIC IO OBRIENMERENET, ~— T OF —HTE 1 T ROLONF | &R E T,
B OHEERE T e T — OB AARICR L CEITSNET,

B 2 ODWBOREINFELIZRWEG AL, HERRICIVERSNDBEIFORIIZE N ORI LFRTIZ
ROET, o, RO OEIEO YO OF G At RICEDhET,
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/=S4 R FTay

Thuy T =R )= TAXFTHEEZ, Tools A=a—"T/ =T ADF T L a AgEEITVWET, /—~7
ARFZ B OT T a7 = BRI L TUThb I ET,

Tools A== —M6H /) —~<TFAXDAT Tools System Help
arkfRELET,

1. Fit to DAC range, preserve offset @ Normalize - Fit to DAC range, preserve offset
0 ZHWELLTAY — U 7S E i

+ @ Normalize - Fit to full DAC range

2. Fit to full DAC range
JLDT —ZDE/MED -1.0, fe K
EA +1.0 1T DI AR T =Y
SHET,

Math...

ETDRDEHBRmEA=2—ZEATS

Ar—)U: Edit A==—® Scale... ZHEHL T T al «F—ZDOELIZL I HOWT, REDO IR ZHE
FLIEEEREZELERDIENTEET,

1. TEERS7 — /L OJF & (Origin) &

RN Ty B RECEES, 3ezte %]
Xb‘“‘/l/'777§il$’{j6j&)@i“@‘ “ertical Scale
/1/0
& ” @ Origin: [ 2000 000 WV
2. TAT ARV UHEFE LI-NEE
X ZDEATOST R I ATIE szl 200

TEET, (64 X—=V [TAT 1LV

- [term
YV BR),

() Al &nalog

@ ) Selected

Fange
=) Al

() Between Cursars

[ ok ] [ LCancel l [ Help

68 AWG5000 $ & AWGT7000 1) —X DAy RB—hkA—H -7 =a7I)L
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Offset: Edit A==—0® Offset... ZHEHAL T, 7F 0l T —FDIRELIZL IO\ T, EFEMADHIEN
TxEd,

1. &7t v M. Voltage F721% Nor-
malized Value Ci% E T&E 7,

2. TAT ARV UV URERLI-VEE Valus
TEEF, (64 =V [TAFDLL UG
:/:/J 5/2%,%..{37\)0 |term
(+) &l &nalog
: () Selected
Range
OF]
() Between Cursors
[ ok ] [ LCancel l [ Help l

Invert: Edit A==—® Invert... AL T, FHELIZL VDT —HENIRIELIENTEET,

1. 7 nal -5 =TI, 7TADE - x|
BT RARVET, ~—H T — —
Z Tk, v—(0) A (D) 1T E Item
T, o

TAT ARV VEETLT-NEX
X, 2o ATas Ry JATER (%) Selected
<kx7. 64 <=2 (rarnee (D)

vV 2R, Hzhos
ol
() Between Cursors
[ ax ] l LCancel ] [ Help

AWG5000 & AWGT7000 V) —X DAy RA—hk2—H 3 =27/l 69
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Horizontal Shift/Rotate: Edit A== —0 Shift/Rotate... ZHHL T IBEL-L P ORET —Z &2 KET
M2 Shift £721% Rotate (RIVIAHZTTR) THZENTEET,

1. ®—F (Shift £72/% Rotate) % &
RUET @ [ —

BRI E TR AT, VT MR i ””:;m Vahe
=R == t
AR R AR E TR ET, ™ g STPEE
2. Linear £7=1% Quadratic O 5 Sk
EEBIRLET, @ e
3. TATLRLL U UHERLIZNEE @ Linear
. 20X AT RS Ry VA TER Y tuadas
TEFET, 64 =V [TATLEL
YV B, Item
oy
@ () Selected
Range
lor 1}
() Between Cursors
I 1] 4 I 1 LCancel ‘ 1 Help

Bk
B  Horizontal Rotate I%. @V IRL N I SNDIGEIZ, HDHEOEZOEH /3 ER OB O B 57H 47
BIEODNZ D2 MR S TNANEINEER T HI-DIHEHEINET,

B Horizontal Shift/Rotate 1%7 1/« F =4 BLO~—Fic@mHsnEzd,
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All High/All Low: Edit > Modify Pattern A==— All High/All Low T. f§ €L7-L oD~ —h +F —Z &
AFZEFE— IR ETHIENTEET,

1. All High F721% All Low Z3&RLF

R

2. MBIZISU T, Level
BHELES,

3. Item BL O Range Zi®INL £,

INTA—=H % @

@

AllHigh/AIl Low
Walue
(& All High
O All Lo
Lewvel
(=) Amplitude/Dffset (3 HighdLaw
Amplitude : 1.000 000 Vpp
Offset : 0.000 000 V

Specified Level information wil be uzed ta
calculate the data.

Item

() &l Markers
() all Analog/Digital

) Selected

Range

[or!

(%) Between Cursors

X

Ok

J [

Canicel Help

J [

2481-010

PRBS: Edit > Modify Pattern A==—¢ PRBS T, f§ EL/72L > Y DT —H&% PRBS ¥ — TEIHIDHZ

EBZTEET,

1. Equation Y AM 5 PRBS /X% —

ZIERLET,

2. Mark Density Z3ZR L £,
3. MEIZJLU T, Level NTA—F %

EHELET,

4. Ttem BL O Range Zi#IRL £,

@
@

®

PRBS

Item

() All Markers
() All Analag/Digital

) Selected

Fiange

@ al

() Between Cursors

X

E quation
[ It

M ark. Density
[@RF;:] @12 [Nomal) O 78
0144 O34
Level
(=) Amplitude D ffset () High/Low
Amplitude : 1.000 000 Vpp
Offset : 0.000 000 V
Specified Lewvel information will be used ta
calculate the data.

0K

J

J

Cancel Help

AWG5000 & AWGT7000 V) —X DAy RA—hk2—H 3 =27/l
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72

User Defined: Edit > Modify Pattern A==—® User Defined CTi%. {8 ELI-L VYO IET —FZERLIZT
DHN R — o THODHIENRTEET,

1. /%% —\Z Binary £721% Hex %13 o
?R L/jzjﬂo User Defined [Z|
2. /{’&—V%ﬁ*ﬁkj}j‘éﬁ)\ W%B Pattern Item
/\_F\’F‘i/rj‘%%%ﬁ)l%u .5‘—“/\‘ () Binary O Hex ) All Markers
AANSTF AR T AN THE @ o1 | (@ ©) All Anaog/Digitsl
ﬁﬁﬁ:k%f%ijﬂo Tatal Bits: 4 O Selected
By b F = D KRR 1,000 Edit Pasition (in bits): 4
T (16 #ETIE 250 3XF), ' @
Level Fiange
3. ;,I;/: 2N U T, Level 2XTAXA—H% @ Amplitude/Offset O High/Low @ &l
,ﬂ\ E L/i j—o @ Amplitude : 1.000 000 Vpp () Between Cursors
4. Ttem BL Range ZEIRL£7, Offset: 0,000 000 V
& — &S\y ]\ & [-/VC%E%( D IE E zﬁ itE ﬁ Specified Lewvel information will be used ta
éh(l/\éi}‘;j/ﬁ\ﬂi‘ ﬁL’\‘\T@IE E calculate the data.
R LCH— D7 =2 ERE oK Cancel Hel
S J J [t

2481-012

28w Edit > Modify Pattern A==2—0 Clock TIZ. ¥ELI-L VP DOF —ZE a7 2 — T
ZBHIEMNTEET,

L S el BEEET )

2. Low Step 3L 8 High Step O fE%

Start Level Item
A jj L i j— o (%) High O Low ) Al Markers
3. W g L:],_.‘[; U . Level INT A—H % Low Step : 1Pts O All Analog/Digital
E E L \i —g— o High Step : 1Pts O Selected
4, Item BL U\ Range Z &N E7, @
Level Range
() Amplitude/Dffset O High/Low ® 4l

@ Amplitude : 1.000 000 Vpp ) Between Cursors
Offset: 0.000 000 V

Specified Level information will be used to
calculate the data.

[ oK J [ Cancel J [ Help J

2481013
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Binary Counter: Edit > Modify Pattern A==—¢ Binary Counter CiX, 8§ ELIZL TP DFT —HE/3AF V-
BTGB RE— THDDHZENTEET,

1. ~"Z—>® 1 (Up counter F£7=
1% Down counter) ZfRELFJ,

Up counter I all 0 2>545FED ., Down O
counter 1X all 1 2B EVET, @

) Dawn
2. MEBIZJSUT, Level NTA—F%

Binary Counter g|

Direction Item

() All Markers

() All Analog/Digital

) Selected
EELET, @
N o o Level Fange
3 : Item io Cl: U\ Range % @ ?R L SE j—‘ °© (@) Amplitude Dffset () High/Low @ a0

@ Amplitude : 1.000 000 Vpp ) Between Cursors
Offset : 0.000 000 V

Specified Level information will be used to
calculate the data.

akK, ] [ Cancel ] [ Help

2481-014
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V=T R

Y=Y R

DUT D52 RREMET AREITOIZIE, LIRLIEE W 7 7 ANV EER T DL ERBDET, IKED
DERVIERSNDGE . W — 7 AEREIZ L > T, REDAEVEHEE T2 07 730 F1EHE %2 KIEIZHE
LT ZENTEET,

= AT FICTFROABRTHEHINET,

B N—RUzT7OEBAEVINEEWVIREEZH DLz neEE

B HHEEEZSHETYDEZ-WEX (ATE 7T XU — a7 y)

FE: A7 2ar 08 B3OV TNV S Tl Wait Trigger 2854 12y hEVE T, Wait Trigger 24712
THIFA T v ary 08 WALV AR— LI TNDILERHYET,

Bk
B AT iar 09 MAERALZEROG AL, VAR EMCHER TS, =AY
V= RAEHATHEIET, LVEWEE T AV BER TEE T,

Sequence P4 K™D

F{EE—R T Sequence NIEEINDBE, ZOUAVRIIIIY —F VAR EDIH RN F RINET, (256 _X—
[Run E—F] &8A),

Sequence VA KT DY A AL
(Thumbnail) 7~ %1 T9, @ @

1. EEORLTIY I THLRINL | o Y

hizin Sequence Tatal Time : 777 Currert :3  Rumni
7%_ {ﬁ ﬂ% Zﬁ Waveform ]7/]' :/}‘ ’7 c:. % Jump Mode : (%) Evert Jump () Dynamic Jur
RENET, BIRLIZ L O 5
MEDVET,

2. WURE B ->TUKE, FDE
NWNZRRENTWABETEDOL #ié
WIEERY—ILF v UNEWVRY
T YT g Ry CERTENE @

ERS

3. Switch to Table #2774 5L7—
TIVRRIZEDVET,

74 AWG5000 $ & AWGT7000 1) —X DAy RB—hkA—H -7 =a7I)L



T =T NEKROFITT, T—T NFER
TliZ. Repeat H7 h=2 Go To DH —
FINRE DY — I R IRT A=A (A
BAJITEET,

Bk

Y=ty

Severee

2481016

B BEFEOWREEY —rACE A TA7DIC, RO FEPRHEINTHVET,
= Waveform List VA RU D TE% Sequence VAL R DEBIAIZRTG YT TR -Ray 7424

= Sequence VA4V R TE/NLEZIREL THE, Bdit A== —® Set Waveform... £721% Insert Waveform...

25

B H{EE—NT. Continuous, Triggered, £7-1% Gated N EBIR I DL, Sequence VA RIIEAZY— 1)

bfEET,

Sequence VA4 RUTIE, TRROTAarNMEHAINET,

RRT A

A

WM Total Time : 772 Currert :4  Running :

Jump Mode : (%) Evert Jump () Dynamic Jump ¢

| IndexNo | Ch1Waveform Ch 2 Waveform m EventJumpTo | Go|

1] *Square960 *Square960

2 ] *Ramp960 *Ramp960 55

3] *Sine960 *Sine960 50

4] *Triangle960 *Triangle960 50

“ *Square960 *Square960 Next
6| *Triangle960 *Triangle960

7 ] *Sine960 *Sine960

8| *Ramp960 *Ramp960

L T L TS PP )

Wait Trigger

o] |

I
on

Repeat ( ZO Tl Repeat count 73 26 IZFR ESNTWVET)

Repeat (Infinite, #ERR 12K L F9°)

Event Jump ( ZOFI T Jump ¥ — 7 Y "B A T v I AK 5 26
IR ESNTWET)

Go To ( ZDHITIE Go To DX —/7 i 26 IR ESINTNE
7)

- i EE:]
=]

YT =

AWG5000 & AWGT7000 V) —X DAy RA—hk2—H 3 =27/l
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Y=ty

V= RIS

V= REER T BT, P E Sequence VA4 R BN TAMLERHVET, LLFOHI T —r

76

AVER D IR IR AT v TR LFET,

1. Waveform List V4> KU T IE 413
RLFET,

2. W% Sequence V4 RudE /L
WZCRIw 7T RRny 7 LET,
AT ITEARELT, BV ET
BTNV 0 EIT A7V T
BB AMI T 78 A TEE T,

3. WIEEY —HF L ZADENLIZEYRL

7"(: f(ﬁ \z . — b‘\‘/ﬂ o N 3)( — 5 é’f'ﬁi—' Cut *Squared60 *Squared60
*Ramn96( *Ramp960
F#LET, o ASil RAMD350 (950 Port=) hsimaos0
- 1 D=l *Triangle960 *Triangle960
v J: < E 7 ) b4 7 7;4 5 75 RN jﬁ f: Lj: Paste - Replace *Square960 *Square960
Edit 7*% Sequence Control Param- Clear RICHNERCE LG
N > N *Sine960 *Sine960
eters ¥ AT T Ry I A& E Delete *Ramp960 *Ramp960
»@‘ R | Insert Waveform... *Square960 *Square9d60
‘\‘ Set Waveform... ]
» Sequence Control Parameters... @ S |
Insert Subsquence... C1 Pos: 0 Fi= Ci
Set Subsequence...

4. Wait Trigger N F =73 NbH L.
=X E DL A ND W

PN THRNCNI T2 /L ET, Index No. 2
5. L —lru ADKTL AL T Repeat DWaltTnggaro
BOURSEESNDE, B NE | DRepea ~—.
EINBEIEREDIRSNET, = 5
Infinite Count: 1
6. BEvent Jump To i, #F#8AXMZ :
FoTHEOH NIEFE2ETELE [V] Event Jump To »
va—o
ARV ME BTNV, k45 (O Next (@) Index No : [—T
b b BRLTIEEN,
[]GoTo
7. L—iru AL AR Go To #—
FoNERETDHE, BESNTZK e ndexNo: | 1
O IIBEDVIRE ., > — s
1% Go To THRESNI=TL A b~ (oK ) [ concel | [ Hew ]
mlEEBLET,

AWG5000 $ & AWGT7000 1) —X DAy RB—hkA—H -7 =a7I)L

File Edit View Settings Tools System Hel

Lreate vignal Fatern...

B Switch to Graphic

Waveform

1
 —
Set Waveform

Ch 2 Waveform

Current: 1

Walt | Repe

Ch 1 Waveform | Ch 2 Waveform |

Sequence Control Parameters

2481017



Y=ty

8. V—HL AL AVNE, TRTO
TFas T eI T —

TSN TEY, AT v I A%

Total Time : 777 T Switch to Table Current: 3 Running :
BN EET,
9. BIRL/I=L AV EAL U R
A RERETNET,
10.Sequence VA R TR L 7= L - -
AL RDY Waveform 74 R R
éﬂijﬁo @:ov @:ov Point: 291 Pts Vaoitage: B 3 N
EVk
B Standard Waveform A7 R « Ry 7 A% AL CEREEERL., DKL EEE Sequence V42 R
AT AL TEET,

B R A AR — R, B % Sequence VA RUIZEHEEY T AZEE A RETT,

B B{FE—R T Sequence BNIEESNDHE, O —F L AERIIES THIBEO I ToNET, > —4~ A
EFITEST DY — L AT AR K x DU —lr R L AV NI T OB REELET,

- BT YL INLOEF~DBR
= S/ RiIf/$7 A—4 (Wait Trigger, Repeat, Event Jump To #3£T} Go To)

B AT HIO L AR (Element Index = 1) 23BIEIZCFEITIINET, 7272L Event Jump To 5
WX Go To DIRENRH LB A ITITZ NI TEITENE T,

B A R_RURELT U TFTOESNIR—FESNET,
= AR/ D Event Input 2 37 X258 FH SNAH1E =
= R/ SF/L D Force Bvent RZ NS NLI- 546
= UE—h-a2< K - EVENt[:IMMediate]

B RRY—TUARITEAEIC Lo TRV ET,

HaOR% BRKY—FUAR
AWG7000 ) —X 1 ~ 16,000 A7 >~
AWG5000 2 —X 1 ~ 8,000 A7 >~

AWG5000 & AWGT7000 V) —X DAy RA—hk2—H 3 =27/l 77



Y=ty

H: EEEEERL—XIZE B LIz — o A BT THE—REL =Ry =T =ty
RI=T e —Ho D2 OOF—FRHVET, 2 DOOF—FRDBENZOWNWTIEL, AT ~NLTHER
FBLTLEEN,

YI—4 2 ZADERK
YT =l A B EDY = AN DY — AT, = VAR OY T — A
EROIENRTEETN, VT =T AR T o= ROl Lid CEEd A, VT —F X347
Tar 09 BIAEH L - T TEET, 7 — L A0 HICEATAEEMIT, AT -~ LT

#ZRLTES N,
1. Subsequence V4> RUDRay 74
]7,7 * Uzl\ﬁ)% NeW Subsequence % vMain Sequence Total Time @ 777
ii%*ﬁ L/i ﬁ‘o g -. s o Jurnp Mode @ (%) Evertt )

2. MWERFITHLWS T —r R
EEREICBMLET, (76 ~—
(L=l 2R T D &),

2481018

3. BA&4H 7Yy L T, Sequence =
Control Parameters &R 1L E9, crome g

Copy

Clear

Insert Waveform...
Set Waveform...

Sequence Control Parameters...

5V @ L5V Point: Valtag

b
@ 281019

78 AWG5000 $ & AWGT7000 1) —X DAy RB—hkA—H -7 =a7I)L



4, YT — AL AR EIZY
BRI N ELET,

F: VY7 —HF R A NI

TiE, Ve =k % Infinite (2%

TETHILITTEER A,

5. ¥ 7 =L ANDT R THTL A
VROEBRBPKE T LD, 7o —
ARG HTIEMT DML ERHYE
4, v~V A% 452727 L T, Name
Subsequence ZEIRL £,

6. LWV T —r o 2AD4RIE A
JiLET,
Waveform List 74> RO 7 —
FUADYANZ, LT —4
VABNBMENET,

Sequence Control Parameters

Index No. 1
“wait Trigger %
Repeat
Inifiriite (&) Count;
Event Jump To

Mext Index Mo

Index Mo

150 /

—

—

[ 0K ] [ Cancel ] [ Help

]

Set Subsequence...

Edit Subsequence

Insert Subsequence...

Name Subsequence...

Go To...

Force Jump Here

Display Properties...

Name Subsequence

Subsequence Mame :

2481021

2481-020

@®

| Sinewave_150

[ ok

J [ Cancel ]

[ Help

AWG5000 & AWGT7000 V) —X DAy RA—hk2—H 3 =27/l
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Y=ty

V=T REwRETD

TERR LTy = o A i3 5712012, ROa~< FAAESH TV,

Set Waveform 3 & U Insert Waveform: ZiHd A== —%ff LT, Sequence 74> R D&M
Yy MERIIHEALET,

Clear: Clear [ZBBINENT=T — ¥ 2L L ET, HEOIEER /R L AL NI T THIENTEET,
=T ADEYDT — X F T RLER A,

Cut B & Delete: Cut & Delete |l AL NN THEIFTCEXET, HHOEFETHTL AL M — |2
B bEEITHIBRTEXET,

Copy. Paste-Insert £ &1 Paste—Replace: 1 >F/- i3 DR L7 =L AL MIRHL TaE—0i—
ANEATHZENTEE T, VU TR —FRDOT —E R~V ADRE LM BICTHAZZIIESBE IO
F 7, Paste-Insert TlL, VDO T —XFT7RLET,

B 15
PLFOFNETIL, Sequence VA4 Ry DT —T7 NWFKRafH LT Cut, Clear & Paste D#lE/RLET,
1. > —Fy ZEERLET,

Total Time : 1 ps B Switch to Graphic

Ch 2 Waveform

2- jjyl\?‘éivjl/]\%ﬁ%j:ﬂbij‘o t Xl Sequence
TITIR AT IIARE S 3By m‘ Tas-1 Time : 1 ps N Switch to Graphic

Sequence Control Parameters...

N ;d‘g% &fcﬁ ) jz‘j—o Export Waveform to File... No| Ch1Waveform 'guih2 Waveform
. Cut BEO Delete [Tl A MH f::ndard Waveform...
MTLIMTZAEEA, ] Delete
Clear
Copy

Insert Waveform...

80 AWG5000 $ & AWGT7000 1) —X DAy RB—hkA—H -7 =a7I)L



3. Cut WEITIN, HBYOT —HT

ZhLET,

HE: Delete TIIZVy 7 R—KDTFT —
AIEDVER AN, Cut TIEHVRE
N=T —EZNI7V TR —=RIZ AL
ESch

4. Clear [TZB|IRL =BV FIZL A

5.

YhOTF—2EYELET, 2T
7=/ Empty &0 EF,

Insert Waveform... #ffif 45,
Waveform List 2> D% AT
xFET,

. Sequence VAL R THEE DK IE

Fat—L7=HL T, KIEEEZvh
L7z & &%, Paste-Insert 721X
Paste—Replace Zffi fFIL £,

Sequence

Total Time : 833.3333 ns BE Switch to Graphic

Index No| Ch 1 Waveform Ch 2 Waveform

Total Time : 2?? B Switch to Graphic

Index No Ch1 Wa\_re_forrn Ch 2 Waveform
(lisinel (4 Empty

Edit View Settings Tools System Help

Undo Ctri+Z
Redo Ctri+Y
Standard Waveform...

Seq Control P it

Cut Ceri+X
Delete Del
Delete All Waveforms

Clear

Copy

Paste

Insert Waveform...©
Set Waveform...
Paste-Insert
Pam-Rlplaeo}

Rename...

AWG5000 & AWGT7000 V) —X DAy RA—hk2—H 3 =27/l
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Y=ty

Event Jump

82

Settings 74> K7@D Event ~X— T, ARV MEBDNRTGA—ZZFHETEXET, Event X—1%, #ifEE—
K723 Sequence M E&fif HTEET,

1. ABAU AT OLEVMEZ R E

LiTo Ch2 | Timing | Run Mode | Trigger | Event | DC Output

2. AR A OREYE (Positive
¥7-1% Negative) ZIBIRL £7°,

Level
ﬁm
B Positive ZEIRTHE, 7L AD

MENY TR T LET,

B Negative ZER I BL, 7 ILAD
MO TYUY T LET,

3. Ux 7 HAI7 (Async F721%
Sync) Z#®IRLF T,

B Async ZIEIRNTHE, Vv
Tl HICEITEINET,

B Sync ZZBIRTHE, Drv 7
BEOKEEH ILI=bETHE
TEnE7,

4, A XUVMATAE—=F A (1kQ
F7213 50 Q) ZRELET,

Polarity Jump Timing Event Impedance

Bk
B (R_UhPx 7 (Bvent Jump) &1E, v — 7 AEARUME B TUIV R DHEEE T,
B Uyl H A7 0%, BEvent Jump & Force Jump O J7 12w HI £,

AWG5000 $ & AWGT7000 1) —X DAy RB—kA—H -7 =a7I)L



V=T R

Force Jump To
Force Jump &1, v — 7 U AN ITHIAEE DX A T TREDMEEZFREL T v TS LHHRETT,

System > Force Jump To... 2% 4 %

Force Jump To

L. Force Jump To ¥ AT 17 « iR A o
ﬂ‘i‘%ﬂ?éﬂijﬁo Target
1. Target TUvL 7 #—F v adgiE B
575>, Index No 234K L F£9°, Current Element
2. Index No ZEIR L7554 1X. Value:
COX T RDA T I AT % @
A7 Lij‘o Value:
! 155
3. Jump Now #27VUv 79 5L, K H ; =5
N7 2—47 R THRELE

LBV B DY ET,

Bk

B (EEHREE L —ZI%. Force Jump &13BIZ Event Jump OHES FF > TUYE T, Event Jump 1%, > —
T RENERINED AR MEE TN X HHRE T,

B Force Jump iZ. Event Jump (2L TWETFT A, Vv 74D Force Jump To X AT 07 Ry 7 A% fEH
LCa—PIZLoTHEENET,

® Force Jump %, Event Jump DF8 E L IX MERILR T, Event Jump D8 EIZBE4%72< Force Jump % 5217
TEET,

AWG5000 & AWGT7000 V) —X DAy RB—hk2—H 3 =27/l 83



Y=ty

RERIVZHD—HIR-TUAVMMZTHERT S

RWor—7 U R ERT AL, Sequence VA RUNIZFR R LENRL72VET, View A==2—D Go To X AT
1y iRy A% AL T, Sequence VARV T Index FFEZIREL CTRARRA LI TIEOKE R TEET,

1. > — L 2%ER . Ama— N — Sequence Control Parameters...
15 View > Go To.... FEi Sl o
T 7 e A= —T Go To... %R —
LET,

AT NIRRT XORA AT RS
Ry ANERINET,

“Squares Cut
“Rampst Delete
*Siness Clear

“Sguared Copy

“Ramp3 Insert Waveform...
BIneS8 BN <ot Waveform
“Squares Paste - Insert
' Paste - Replace /

"Siness
Go To...

“Squared
“Ramp3 Foree Jump Here

“Siness Display Properties...

SquareSoy

“Ramnaen

2. Go To & —74> vk (B#E)kE) LL
. Index No 3R L £,

3. EAEAALET,

@)

"% ) (o] [

4. Go To AT Y By /AT OK % Saquence , -
TV 73 5HE, %%ﬁ‘?ﬁﬁiﬂéﬂfi{j 4 WL LR W Switch to Graphic  Current: 1 Running :
I%. &:@J D 7{%’5 j/) D i?—o Index Ne| Ch rm Cch nm Wait | Repeat | EventJump To | Go 3

g
B Waveform V(> U= Waveform List V4> R T Go To FAT a7 « iRy 7 ANfEHTEET,
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TR, ERA L TR B R — X OIEEE FAT T 55 k%~ L ET, LU RO T,

2F v XN BT IVEMEHALET,

BT D R LRSS

1. EROBEET 74NV MILET,

2. Run Mode T Continuous Z &R L
i—a—o

3. Standard Waveform & A7 127 R+
JAERMBEHLT, TRRO LG
BEERLET,

B Waveform Length: 960 points
m Cycles: 5
B Amplitude: 1.0 Vp—p
B Offset: 0.5V
4. A7 w7 3 TIERLTZEIEA Ch 1
2By hLET,

5. WIEIZ Chl-Square &\ H4 Fra o
TET,

P

File Edit View Settings Tool:
» Factory Default Setup
Open File...

Ch1 Ch2 | Timing | Run Mode | Trigger | Event | DC Output

? Continuous @® Triggered @® Gated ® Sequence

AN

—Output vallie fc
( 2 ‘ :

Function e
ﬁ@‘% |gqua,e N 3 | (=) smplitude / Offset
() High / Low
Timing
Amplitude
Wwiaveform Length % ’_ aB0 bRl 1.000 Ypp
Offset :
Cycles ~ | 5 e D500
Operation
(%) Set ko Index Mo 1 at Ch
e Target W avefor
() Create only | |
() Ovenwrite
“waveform Name: ’
|Eh1 Squard o |

AWG5000 & AWGT7000 V) —X DAy RA—hk2—H 3 =27/l
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10.

. Standard Waveform ¥ A7 127 « iR

JAEAF LT, TR Eo7eth A
WEERLET,

B Waveform Length: 1024 points
® Cycles: 3

B Amplitude: 1.0 Vp—p

B Offset: 0.5V

AT w7 6 TR LIZE % Ch 2
ey hLET,

W IZIZ Ch2-Sine EWO& A DT
7,

T I a s W OMmRELITOZDIT,
Display Properties Z A7 127 <R
JAZMALTCCh1 & Ch2 o
Marker: 7 — X% IERRIZLET,

Chl OEFLEFRILESIZT DD
\Z. Ch 2 D FEDOE% I Z TN E
TO
H—INVEFEHLTL YR EL
9,

B —YAEHOIIICEEET,
B Ch2 EHAEBRINLET,

B 571>/ L7, Delete, Selected.
Between Cursors Z &R L £,

B OK #2777 LFET,

AWG5000 $ & AWGT7000 1) —X DAy RB—hkA—H -7 =a7I)L

Function Tevel
"\\'." Sine I (%) Amplitude £ Offset
) High / Lows
Timirg
Amplitude : ’—
Waveform Length 1024 1.000 Vpp
Offset: ,—_
Cucles v 3 0500
Operation
(%) Getto Index Mo atChlz2 «

Target Wavefor@e

() Create only

() Overvrite

W aweform Mame:

Ch2-Sing
Chi Ch2
Analog Analog
[T Marker ] Marker

@: 0009V

[—ESTMT
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11. o heFIT35L, Ch1 & Ch2 D m
N % NI == N H : H ygh
{gfgéi%?;@mg%ijﬁw WO A Clos; [ DS9Fs  copos [  Uo0PRE G (& Q;i*

12. R EERAFLET, File Edit View Settings Tools
Factory Default Setup Ctri+N

Open File... Ctrl+0

@ Save File Ctri+S

Save File As... F12

= RDERERE

1. BEBROREEZT 7H/VMILET, File Edit View Settings Tool:
_» Factory Default Setup

-'J Open File...

2. Run Mode T Sequence &R L £

'g"‘o ch1 ch2

@ Continuous SEqUEnCE

AWG5000 & AWGT7000 V) —X DAy RA—hk2—H 3 =27/l 87
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3. Waveform List 74> K7 D Prede— k_Vew Setngs_Tedk_Spiam ter
fined ~— 715 *Sine960 0 JE bt aomomain semimt  ntictows [ ] RS N
ZEIRLTChl O —Fr 201 | | i
FHOENMIZEYILET,

4. [AARIT . *Triangle960 % &L T
Chl1Dy—4r A0 2FEHDOEL
Wy LET,

5. MMUCTROIIBRIALPWEIERL s sasmea
LTC.ChlDy—4rAD 3 %H T M sugoons;
@'E}Vﬂ:“hy]\[/i‘j‘o 1 Total Time : 240 ns
B Waveform Length: 960 points

m Cycles: 5

B Amplitude: 1.0 Vp—p

m Offset: 0.0V
B 4 Sine-1

6. =T AD 3FEHDE/NEERL . |67 € oncn A

TRy T T w7« A=a—5 Copy ol

FRINLET, st .
o .
Insert Waveform... \\‘
Set Waveform.... Noints
6 ’
::r::mHm . o m &
Display Propacties.s N | | LLUE W

7. —HF L AD 2 FHDOEIN A
WLT. Ry T TyT Ama—0b
Paste-Insert Z &R L £,

Delete

Clear

Copy

Insert Waveform...
SetWaveform...

: ; Font: 16 Prs Vokage: m ¢
Display Properties._. PR capex [ UPE @ W R R G
.
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8. abv—&XNEENRAL T VIR 2
IZ_—RARENET,

9. Switch to Table 727Uy 71
T 7T =T NRRICEELET,

10. KD EHNE Y — i A /ST A—
RELET.

B [ndex 1: Wait Trigger On
= AD 1 FREM TS
ANCRNI T2 FREBET,

B Index 2: Repeat count Infinite
Sine—1 & MEFRIZHRDIKL F
7,

B Index 2: Event Jump To Next
ANCMEFEZETHE, VU —
U RFIR DT AT Y
TLET,

B |ndex 3: Repeat count 1000
*Triangle960 D% 1000 [A]
ML FET,

B Index 4: Go To 1
= RFIA T I A 4 D
WEH W% A TvI7 A1
Uy LET,

11.Run R ZHL Ty — o7 AN
ERICEMET DL EMERLET,
Running JREET, AL DEMDT
= A= g DNEMELET,

Sequence

Total Time : 320 ns [_3Switch to Table Current: 5§

Total Time : 777 B Switch to Graphic  Current : 4

Running :

Running :
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RELER

10MHz Reference Output =217 %
iR Sk, 16, 19

ENGLISH TERMS

Add Input
B v, 19
All Outputs On/Off IR &Z
AT —HA— 30
AT 7SR L, 34
Analog Output = %7 %
AT 7SRV, 14
Binary Counter
Edit A==— > Modify
Pattern, 73
Channel ~2—
Settings V4> R/, 35
Clear
Sequence V4> K77, 80, 81
Waveform 74K/, 56
Clock Pattern
Edit A==— > Modify
Pattern, 72
Configuration Utility Z A 7 &
TR IR, 6
Cut #eEH
Waveform 742K/, 65
DAC 45 fig ke
Settings 4> R/, 35
WIET —H DTy AR —
K, 55
DC Output 2R/ %
R/ SRV, 14
DC Output ~=X—
Settings V4> K7, 36
Direct Output, Settings V4>~
7, 36
Display Properties Z A7 1«
Ry A, 32
Divider Rate, 37

Edit A==2—
Modify Pattern > All
High/All Low, 71
Modify Pattern > Binary
Counter, 73
Modify Pattern > Clock, 72
Modify Pattern > PRBS, 71
Modify Pattern > User
Defined, 72
WE=E, 58
=&, 80
Event Input =t %7 %
Rl 2 N3V, 14, 77
Event Jump, 83
Event Jump To
Sequence control
parameter, 76
Event page
Settings VA4 R, 82
External Clock Input
%ISR, 16, 19
Factory Default
Startup setting, 48
File A== —
WEZE, 44
Force Event 7R &Z
AT —HAN— 30
B A panel, 77
Force Jump To
System A==—, 83
Force Trigger R 4>
AT —HAN— 30
Go To
Sequence control
parameter, 76
Go To X ATl <Ry I A
View A==—, 84
GPIB a7 ¥
U7« x%/1, 15, 18
GPIB/LAN D% &
System A==—, 5
Graphic 7R~
Waveform 742K/, 56
Hold
Preferences Z A7 a7 <R
7, 31
Insert Waveform

Sequence V4R, 80

AWG5000 & AWGT7000 V) —X DAy RA—hk 2 —H 3 =aF7/L

]

Integer
W7 +—~>h, 45, 55
Integer JE
BT — 2D AR—
K, 55
Interleave Output =R 7 ¥
A 7SRV, 14
Invert
Edit A==—, 69
LAN =2 %7 %
U7 %0, 15, 18
Last Used File
Startup setting, 48
LCD o i
Preferences Z A7 17 <1y
A, 31
Marker Output = 7%
Al 7S, 14
Multiplier Rate, 37
Offset
Edit A==—, 69
OS DVARNT « T 4 A7, 12
Oscillator Output
# L, 19
Paste—Insert
Sequence 742K/, 80
Waveform 74> K7, 66
Paste—Replace
Sequence 74> K7, 80
Waveform V4> N7, 66
PRBS
Edit A==— > Modify
Pattern, 71
Preferences A7 a7 « iRy
A, 31
Raw Socket
GPIB/LAN Configura—-
tion, 5
Real
BIE 74—~k 45, 55
Real &=
BT — 2Dy AR —
Ik, 54
Reference Clock Input
BER L, 16, 19
Remote Command Log
Preferences # A7 17 « 7R
7 A, 31
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Rename
Edit A==—, 63
Repeat
Sequence control
parameter, 76
Repetition Rate, 37
Run State 2 bm—/1, 34
Run R 4& >
AT — B ZN—_ 30
B A XL, 34
Run &—R~_X—
Settings V4> R/, 25
Sequence Control Parameters
EAT7ar e RyJA, 76
Sequence VAR, 74
ARGV =2 A BT =—
Z, 23
All High/All Low
Edit A==— > Modify
Pattern, 71
Set Pattern
Edit A==— > Modify
Pattern, 72
Set Waveform
Sequence V4> Rt7, 80
Sequence A==—, 76
Settings VA4 K7
ARGV =2 A BT =—
Z, 23
Shift/Rotate
Edit A==—, 70
TekLink =17 %
U7« s%L, 15, 18
Timing ~X—
Settings V4> R, 37
Trigger Input =7 %
B SV, 14
Trigger X —3
Settings V4> Rt7, 26
USB 274
R/ SV, 14
U7 «8x)L, 16, 18
User Default File
Startup setting, 48
VXI-11 Server
GPIB/LAN Configura—
tion, 5
Wait Trigger
Sequence control
parameter, 76
Waveform List 74K/, 62
AP —2 A BT z—
Z, 23

92

Waveform Rotation
Settings V4> K77, 35
Waveform 74 R/, 56
A= A AT = —
A, 23
Zeroing, 40

&

TAa
Sequence VAR, 75
NV
T AT I Edit A==—, 64
7YY, 1
BRIZTHE WL

\Z, il

Ly

A B —=—7T" 39, 41

Ao B R
System A==—, 41

2
TAVRD - H T
ayha—)Le 4 RUDFE
AU, 29
AgY = A BT = —
A, 23
A
TV AN, =T A, 7T
A

Tools A==—, 67

o)

FTar DA A=)
System A==—, 10

FT7IAL - F—K, 6

F R —F 4T AT LD
AT, 11

FR—FT 4T AT BDY
ARNT, 12

OS DYARNT « T 4 A7, 11

OS DYART « T4 AT DIE
B, 11

HY
MR FERERE, 9
T hex L AU, 7T

AWG5000 $ & AWGT7000 1) —X DAy RB—hkA—H -7 =a7I)L

BRELEAE, 2

s

e anix Ex 1T 95, 45
IR EE IO T, 46
DA, 7

<

I)—=27, 2
[+
47—k

Run £—F, 25
—
B, 8
A VI

AWG5000C > U—X, 18
AWGT7000C > U—X, 15
ayvha— VR E
EHIik, 28
ayha—)L - 4R
KO, 29
avha—)Le 4RI ~DT
JEA, 26
ayvha—L R0, 20

[

RRY = AR, 17
YT =R, T4
YERK, 78
B ARA VTR
Sequence V4R, 74

L

HO®IE, 8
HAhodr /47, 34
W, T
=R
Edit A==2—, 74
Run £—F, 25
YT =R, T4
VLA, 87
= AR, 7
U RES, 1T
AT L AU, TT
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T (E il D HLAL
Waveform 7> K7, 32,
56
7K gl D BT
Waveform V>R, 32,
56
=7 1%, 61
AGN =V e A H T2 — R 23
Al — )
Edit A==—, 68
AR —R TV, 1
AT — A AIN—
A= A BT =—

A, 23
AT —H A 3—, 30
R — I, 57

ca

AT 7SR, 14
B 7L ea ba— L
a7/ ay 7 fEER, 21

Z

HEHI
Sequence 74> K7, 80
—rr A, 87
HEUEP I, 85

VING =T o —lrY, 11

BAFIvI OxrT Ay a
FU5, 11
By F ATY =2, 22

5

T RNFER
Settings A==—, 38

F XL R A 2 —
System A==—, 39

T
TE U AW

Waveform List 74> K

7, 62

TNV, 42
T T FIVIERE, 47
B, 2
BRI AR OB IREE E, 48

T —7 VKR
Sequence V4K, 75
Waveform 74> Rt7, 56

&

IED EA, 2
N
Run &—F, 25

/A
WK E
EHETD, 63
KT —#
AR —N, 49
T AR —b, b4
BT —ZD A R—Nk, 49
AWG 77 AV T4 —~<

K, 52
DTG 774V 74—~
I, 52
THXANT 7 ANV TH—~v
I, 53

WIETF —Z DTy AR —}, 54
WHT —ZDT7+—~vh
WD aX7 ¢, 63
WIEDT —H 73—k
KR EX R T 5, , 45
A A=A AP
Edit A==—, 63
W R e, 62
W4
EHT5H, 63

1z

EERE YR —X
FEARZT VT, 24

12

FohT— 7 ~D T, b

)—<TAR
Tools A==—, 68

&

IND—F e /NTTARN T
NRYET Y, T

AWG5000 & AWGT7000 V) —X DAy RA—hk2—H3 =27/l

(03

Ve R=V/a % AL (357
Edit A==—, 59
BER], 85

[

RNy T Ty 7 F—/ R, 28

S

~==27 ), X
~—H N
A B =) =T F >, 40

&

Ama—~DT TR, 26
)(::_,_../{_.
AT =0 A FT = —
A, 23

K

R
System A==—, 31
PR
Waveform List 7 4K
7, 62
LM EEHTD, 63

L
V£ —kPC
Birparha—)L, 6
JE—hea<w RN —
AIV—2 A BT = —
A, 23

n

LY, Bdit A==2—, 64
1 e
Run &—F, 25

ay s/ a7 fRER
A A=A N =t
b, 21

]
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